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Introduction

Welcome to Adobe Photoshop CS4 On Demand, a visual
quick reference book that shows you how to work efficiently
with Photoshop CS4. This book provides complete coverage
of basic to advanced Photoshop skills.

How This Book Works

You don’t have to read this book in any particular order.
We've designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you're done.

What's New

If you're searching for what's new in Photoshop CS4, just look
for the icon: New!.The new icon appears in the table of
contents and throughout this book so you can quickly and
easily identify a new or improved feature in Photoshop CS4.
A complete description of each new feature appears in the
New Features guide in the back of this book.

Keyboard Shortcuts

Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or c=)+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the Web at www.perspection.com.

How You'll Learn

How This Book Works
What's New

Keyboard Shortcuts
Step-by-Step Instructions
Real World Examples
Workshops

Adobe Certified Expert

Get More on the Web

Xix



Step-by-Step
Instructions

This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task.

Real World Examples

This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won't waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.
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Using Selections to Loyor masks ara easy lo craate; you select a layer and then lick the

dd Layer Mask bution. Unfortunalely, wilen you create & Mask 15 s———— 10~
Generate Complex way, 1 up 19 you to delina the transparent areas, using drawing or Easv to-follow
painting t0ols, There is ancther way 10 generste a mask, and that's by = :
Layer Masks making a salection firsL When you click the Add Layer Mask bution, |ntr°duc"0"s
Phatoshop searches the dacumen: for sny selected aress. f 1 doesn't
find any, il Croates a blank (2 whila) mask However, il you st select focus on a
&n area of the image, Photoshop interprets the selection as the area -
o0 e 1o it sk single concept.
Use Selections to Generate
Masks

Open & document

Selectthe areas of the image you
want 1o preserve.

Click the Add Layer Mask burion.

Phatoshop generates a layer mask
based entirely on your selection,

Illustrations
match the
numbered
steps.

Did You Know?

You Gan apply layer stples to a maskod
image. Croate the mask, and then click
the Add Layer Styla button, locates at
the biottom of tha Layers pansl. Then
usa any of Photoshop s layer stylss,
such as Drop Shatw, or Bevel and
Embass The layer styla will only ba
anpliad to the visible porton of the
imaga.

Numbered
See Also steps guide
s b St i you through
o0 selecting arass of an image using
et ot each task.
See Also points you to Did You Know? alerts
related information in you to tips, techniques
the book. and related information.
®e06 Marble.psd @ 66.7% (Levels 1, Layer Mask/8)
Real world

examples help
you apply what
you've learned
to other tasks.

@[ Boc 2.25M/5.110 ] y



Workshops

This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert

This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Photoshop CS4.
Each Adobe Certified Expert certifi-
cation level has a set of objec-
tives, which are organized into
broader skill sets. To prepare for
the certification exam, you should
review and perform each task
identified with a Adobe Certified
Expert objective to confirm that
you can meet the requirements for
the exam. Throughout this book,
content that pertains to an objec-
tive is identified with the Adobe
Certified Expert logo and objective
number next to it.

Workshops

Introduction

The Warkshop s all sbout being creative and thinking outside of the box, These workshops wil help
your right-brain saar, while making your left-brein happy by explaining why things wark the way
they do. Exploring Photashop's possiailities is oreat fun; however, ahvays stay qrounded with the
knawledge af how things work. Knowledge is pawer.

Getting and Using the Project Files

Each project in the Workshop includes a start file to help yau gel sterled with the project, and a
final file 10 provide you with the resuhs so you can see haw well you ccomplished the task.

Before you can use the project files, you need ta download them fram the Web, You can access the

files at wwwperspection, com. After you dewniaad the files, uncompress them into a fokder an yaur
hard drive.

Project 1: Scaling an Image Using Content-Aware

Skills and Tools: Content-Awara Scale, Refine Edge, and Blending Mode

One of the exciting new fetures in Photoshop C54 is Cantent-Auare Scaling. This command laoks
for the facal point in your image and then identifies pixel areas that are less mportant and adds or
sublracts pixels in those areas s necessary 5 yau scale the image, leaving the focal point
unchanged {unless yau go 100 far]

The Project

Inthis praject, youll use the Content-Aware Scaling fezture along with ather refining tocls to mod-
ify and enhance a phatograph.

The Process

Open the fle Red_Rock_Canyen_startpisd in Photashop and then save it 2s
my_Red_Rock_Canyon.psd

Be sure you're not warking on & lacked layer [like the Background), If necessary, dauble click
an the werd "Backgraund” and rename it. Duplicate the layer by dragging it on ta the New
Leyer icon or using ClrkJ IWin} Command-+] (Mac]. Duplicating the layer wil ensbie you to

The Workshop
walks you through
in-depth projects
to help you put
Photoshop to
work.

Adobe Certified Expert

About the Adobe Certified Expert {ACE) Program

The Adube Certified Expert (ACE) program is for graphic designers, Web designers,
systems integrat dded resellers, and business
seeking official r eca Jnition of their expertise on Adobe products,

What Is an ACE?

An Adobe Certified Expert is an inzllm\lu.‘d whn I].«Q passed an Adobe Preduet Profi-
@ A i

Mna\r produt 'S and Master certification
become an ACE, you must pass one or more product-specific proficiency exam and

sign the ACE program agre
cial benefits

L. When you become an ACE, you enjoy these spe-

+  Professional recognition
+  AnACE program certificate
+  Use of the Adobe Certified Expert program logo

What Does This Logo Mean?

1t means this book will prepa
Adobe Photeshop €54, The
organized into broader skill sets. Throughout this book, content that pertains 10 an
ACE objective is identified with the following Adobe Certified Expert loga and
tive number below the title of the topie:

you fully for the Adobe Certified Expert exam for
ificat has a set of objectives, which are

=

525

Logo indicates a
task fulfills one or
more Adobe
Certified Expert
objectives.

Introduction  Xxi



Get More on the Web

In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Photoshop CS4. Some of the
information includes:

Transition Helpers

¢ Only New Features.
Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools

¢ Keyboard Shortcuts.
Download a list of keyboard
shortcuts to learn faster ways
to get the job done.

More Content

¢ Photographs. Download
photographs and other
graphics to use in your
Photoshop documents.

¢ More Content. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.
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Keyboard Shortcuts

Adobe Photoshop CS4 is a powerful program with many commands, which some-
times can be time consuming to access. Most menu commands have a keyboard
equivalent, known o3 o keyboard shortcut, as a quicker alternative to using the
mouse. For example, if you want to open a new document in Photoshop, you click
the File menu, and then dlick New, or you can abandon the mouse and press Ctr«N
{Win} er (:+N (Mac) to use shortcut keys, Using shorteut keys reduces the use of
the mouse and speeds up operations. If a command on a menu includes a keyboard
shortout ta the right of the command name, you can perform the action by pressing
and holding the first key, and then pressing the second key to perform the command
quickly. In some cases, a keyboard shortcut uses one key or three keys. For three
keys, simply press and hold the first two keys, and then press the third key. Kay-
board shortcuts provide an alternative to using the mouse and make it easy to par-
form repetitive commands,

Finding a Keyboard Shortcut

Photoshop contains keyboard shorteuts for almost every command and task in the
program. To help you find the keyboard shortcut you're looking for, the shortcuts are
organizad in categories and listed with page numbers,

Actions, 21 History, 20
Adobe Bridge, 23 Image, 13
Animations, 21 Layers, 13
Blanding Modes, 16 Paths, 13
Brushes, 18 Photoshop, 2
Channel Palettes, 18 Quiick Masks, 19
Color, 17 Selecting, 10
Dialog Boxes, 21 Tools, 3
Display, 8 Transform, 21
Edit, 3 Type, 10

File {Documents), 2 View, 8
Filters, 18

If you're searching for new keyboard shorteuts in Adobe Photoshep CS4, just look
far the letter- M. The N appaars in the Keyboard Shortcuts table 50 you can quickly
and sasily identify new shortcuts

Additional
content

is available
on the Weh.



Customizing the Way
You Work

No description of Adobe Photoshop would be complete with-
out that well-known, but little utilized area called Preferences.
Photoshop preferences serve several purposes. They help
customize the program to your particular designing style, and
they help you utilize available computer resources to
increase the overall performance of the program.

By modifying File Handling preferences, such as append-
ing a file extension on the file, or being asked when saving a
layered TIFF file, you can streamline the file saving process.
In addition, you can change the way your cursors look. For
example, do you want your paintbrush to look like a paint-
brush when you paint, do you prefer a precision crosshair or
the actual brush size shape, or the shape with a crosshair?

As you use Photoshop, you'll come to realize the impor-
tance of working with units and rulers. Precision is the name
of the game when you are working with images. What about
the color of your guides, grids, and slices? No big deal, you
say. Well, if you've ever tried viewing a blue guide against a
blue-sky image, you know exactly why guide color is impor-
tant. By working through preferences such as Image Cache,
Scratch Disks, and RAM (Random Access Memory), speed
increases of up to 20% can be achieved.

In addition, customizing the program helps make you
more comfortable, and studies show that the more comfort-
able you are as a designer, the better your designs. Plus,
being comfortable allows you to work faster, and that means
you'll accomplish more in the same amount of time. What
does setting up preferences do for you? They make
Photoshop run faster (up to 20%), you work more efficiently,
and your designs are better. That's a pretty good combina-
tion. Photoshop doesn't give you Preferences to confuse you,
but to give you choices, and those choices give you control.

Optimize Photoshop

Set General Preferences

Maodify File Handling Preferences
Work with Interface Preferences
Work with Cursors Preferences

Control Transparency & Gamut
Preferences

Work with Units & Rulers

Work with Guides, Grid & Slices
Select Plug-Ins

Select Scratch Disks

Allocate Memory & Image Cache
Work with Type

Manage Libraries with the
Preset Manager

Customize the Workspace
Define Shortcut Keys
Create a Customized User Interface

Use Drawing Tablets



Optimizing Photoshop

Photoshop is a powerful program, and as
such, requires a tremendous amount of com-
puting power. When working on large docu-
ments, a poorly optimized Photoshop
program will mean longer processing times
for your files. That's the bad news if you have
a deadline to meet. The good news is that
Photoshop can be configured to run more effi-
ciently. To optimize Photoshop, click the Edit
(Win) or Photoshop (Mac) menu, point to
Preferences, and then click Performance. The
Performance preferences dialog box contains
options that will help maximize the perform-
ance of Photoshop.

History States

History States control the number of undos
available. In fact, you can have up to 1,000
undos (ever wonder who would make so
many mistakes that they would need 1,000
undos?). Unfortunately, increasing the number

Preferences

General Performance

Interface Memory Usage
Available RAM: 1963 MB

Ideal Range: 1079-1413 MB

File Handling
Performance
Cursars

Let Photoshop Use: |1374

Transparency & Gamut

Units & Rulers =

B

Cuides, Grid & Slices

fluasins Scratch Disks

Active? | Drive

vpe

Free Space Infarmation

#  Macinosh HD 23.17GE

Description

MR (70%)

.

of History States will ultimately increase the
amount of RAM Photoshop uses to manage
the History panel. Assighing more RAM to
manage History means less memory for
Photoshop to perform other operations, and
will reduce the performance of the pro-
gram. If you are experiencing problems
with slow performance, lowering the num-
ber of History States frees up more RAM,
and permits Photoshop to operate more
efficiently.

Scratch Disk

When your computer doesn't have enough
RAM to perform an operation, Photoshop
uses free space on any available drive,
known as a Scratch Disk. Photoshop
requires b times the working size of the file
in contiguous hard drive space. For exam-
ple, if the working size of your file is 100
MB, you will need 500 MB of contiguous

History States
b OK
History & Cache (" Cancel )
: . -
3 ————
History States: |20 " Prev
Cache Levels: |4 2

_ Next

GPU Settings
Detected Video Card:

Enable OpenGL Drawing
vanced Settings



hard drive space, or you will receive an error
message: Out of Scratch Disk Space (I hate it
when that happens). Using additional hard
drives gives Photoshop the ability to divide
the processing load and increase perform-
ance. Photoshop detects and displays all
available internal disks in the Preferences dia-
log box. Scratch disks must be physically
attached to your computer (avoid networks
and removable media, such as zip drives, or
rewriteable CDs or DVDs). For maximum
speed, avoid USB, and use 4- or 6-pin
FireWire drives. Benchmark tests show
FireWire drives provide up to a 20% speed
improvement when used as Scratch Disks.
Think of saving one hour out of every five, or
one full day out of every five. That's not too
bad. For best results, select a scratch disk on a
different drive than the one used for virtual
memory or any large files you're editing.

Memory & Image Cache

Photoshop functions in RAM (actually all appli-
cations work within RAM). To run efficiently,
Photoshop requires 5 times the working size of
the open document in available memory
(some tests indicate 6 to 8 times). Strictly
speaking, the more RAM you can assign to
Photoshop, the more efficiently the program
operates, especially when opening large docu-
ments.

RAM usage is determined by the working
size of the document, not its open size. As you
work on a document, you will eventually add
additional layers to separate and control ele-
ments of the image. As you add these new lay-
ers, the working size of the file increases.

RAM memory allocation

Preferences

General Performance

Interface

IMemnrv Usage
Available RAM: 1963 MB

File Handling

Performance

Ideal Range: 1079-1413 MB

Cursors

Let Photoshop Use: 1374

ransparency & Gamut

Units & Rulers -

B

Cuides, Grid & Slices

Plug-Ins

Scratch Disks

Type
Active? | Drive

Free Space

) Macintosh HD ~ 23.17GE

> W N e

Information

o3
1 History & Cache /E\
History States: 20 v [ ——
Cache Levels: |4 *l /TT.
MB (70%) ST
+
GPU Settings

Detected Video Card:

Enable OpenGL Drawing
| Advanced Settings

Description

Available Scratch Disks

Chapter 3  Customizing the Way You Work
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Setting General
Preferences

Adobe
Certified| PS 13
Expert

Work with General Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click General.

Click the Color Picker list arrow,
and then select Adobe or another
operating system (Windows or
Macintosh).

Click the Image Interpolation list
arrow, and then select Nearest
Neighbor (Faster), Bilinear, or one
of the Bicubic options.

Select the various options you
want to use:

Auto-Update Open Documents.

Creates a link between the
open image and the image file
on disk.

Beep When Done. Makes a
sound when an operation is
complete.

54

Photoshop's General preferences help you configure some of the more
common features of the program. Image interpolation settings, as well
as the History log, are set up in General preferences. Other options,
such as beeping when an operation is finished, auto-updating open
documents, and using the Shift key for tool switching, can all be turned
on or off in the Options area. The History Log lets you save all the
History States performed on a particular document. For example, when
you open an image, all the adjustments and actions performed are
saved in a text file. This gives you access to valuable information, and
lets you reproduce the steps performed on one image to correct
another.

Preferences.

General Color Picker: [ Adobe H Ol
'”‘l:a"wg Image Interpolation: | Bicubic (best for smooth gradients) =] Cancel
Perfarmanes Options —
Cursors ] Auto-Update Open Documents Animated Zoom C Next )
Transparency & Gamut ] Beep When Done ™ Zoom Resizes Windows S
Units & Rulers, ™ Dynamic Color Sliders "] Zoom with Scroll Wheel

Guides, Grid & Sticas ™ Export Clipboard "1 Zoom Clicked Point to Center

fuarins ¥ Use Shift Key for Tool Switch Enable Flick Panning

" ¥ Resize Image During Paste/Place
[ History Log
Save Log Items To: (<) Metadata
Text File Choose
Both

Edit Log ltems: | Sessions Only

(“Reset All Warning Dialogs )



Dynamic Color Sliders. Previews
color effects within the slider
bars.

Export Clipboard. Transfers a

copied image to the operating
systems clipboard. et

Cursors

Use Shift Key For Tool Switch.
Allows you to use the keyboard
shortcut when two tools share

the same slot in the toolbox.

Resize Image During Paste/
Place. Allows you to resize an
image during a Paste or Place.

Animated Zoom. (New!)
Enables continuous-motion,

Preferences

Color Picker: | Adabe )

Image Interpolation: | Bicubic (best for smooth gradients) - ]

Options
] Aute-Update Open Documents Animated Zoom
"] Beep When Done ¥ Zoom Resizes Windows

¥ Dynamic Color Sliders [ Zoom with Scroll Wheel
™ Export Clipboard [ Zoom Clicked Point to Center
™ Use Shift Key for Tool Switch Enable Flick Panning

™ Resize Image During Paste/Place
1 History Log
Save Log Items To: () Metadata
TextFile ( Choose
Both

Edit Log Items: | Sessions Only =+

(“Reset All Warning Dialogs )

T
C e ) |
T:

smooth zooming in and out of
your document. Must have
OpenGL on your computer.

Zoom Resizes Windows. Forces
the image window to resize
when zoom is selected.

Zoom With Scroll Wheel.
Determines whether zooming or
scrolling is the default operation
of the scroll wheel.

Zoom Clicked Point to Center.
(New!) Centers the zoom view
on the clicked location.

Enable Flick Panning. (New!)
Enables quick mouse movement
over the image instead of holding
down the mouse.

Select the History Log options you
want to use.

Click OK.

Did You Know?

You can turn a text box into a slider.
You can use any text box which dis-
plays a numerical value, such as font
size, like a slider. Point to the name of
the box (which changes the cursor to a
hand with arrows), and then move the
mouse left to decrease or right to
increase the displayed number.

Chapter 3  Customizing the Way You Work 55



i 1 Sooner or later, you'll have to save the file (document) you've created
MOdlfylng Flle in Photoshop. The final output of any document is contained within a

Handling specific file format such as TIFF, EPS, JPEG, or BMP. In fact, Photoshop
lets you save files using over 15 different formats. The File Handling
Preferences preferences provide several options that modify what information is

saved with a file. Image previews are typically very small, adding very
little to the file size of the saved document. Once saved you may want
to open, print, and possibly even modify the document using other
image-editing applications. The File compatibility options help you save
a file that will be transportable to other applications.

Work with File Handling Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to

Pref
Preferences. pelejenses
General File Saving Options C oK )
g = = Image Previews: | Always Save - ( N
Click File Handling. o AT, ~Cancel
™ icon T Full Size - T——

¥ Macintosh Thumbnail

™ Windews Thumbnail PR——

Select the File Saving Options you

want to use: Append File Extension: | Always D
™ Use Lower Case
Image Previews. Select from: File Compatibiity
A ——— e ——
Always Save, Never Save, or Camera Raw Preferences...
A k Wh S . M Prefer Adabe Camera Raw for Supported Raw Files
S en saving. [lignore EXIF profile tag
. ™ Ask Before Saving Layered TIFF Files
|COII. Saves previews Of the Maximize PSD and PSB File Compatibility: | Ask D
images (Mac). Version Cue

™ Enable Version Cue
Full Size. Saves full-size
previews for use as FPO (For
Placement Only) objects in
Desktop layout programs
(Mac).

Mac Thumbnail. Saves
previews viewable when using
the Mac File Open command
(Mac).

Win Thumbnail. Saves
previews viewable when using
the Win File Open command
(Mac).

Append File Extension. Lets
you choose whether or not to
append the file extension
(Mac).

Use Lower Case. Choose to
have upper or lower case
extensions.

Recent file list contains: |10 | files
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Select the File Compatibility options
you want to use:

Camera Raw Preferences Click
to choose from options such as
default image settings, cache
size, DNG file handling, and
whether or not to open JPEG
and TIFF files with Camera Raw.

Prefer Adobe Camera Raw for
Supported Raw Files. Open
supported raw files in Camera
Raw.

Ignore EXIF Profile Tag. Ignores
color space metadata attached
to digital camera images.

Ask Before Saving Layered TIFF
Files. Lets you create multi-
layered documents, and then
save them using the TIFF format.

This is a distinct advantage
when you need to use multi-
layered files and you don't want
to save them using Photoshop's
proprietary format (PSD).

Maximize PSD and PSB File
Compatibility. Lets you save
PSD files that can be opened in
earlier versions of the program
and PSB (Large Document
Format) files.

Select the Enable Version Cue
check box to enable Adobe Version
Cue in your work process.

Enter the number of files (up to 30)
to keep in the Recent File List box.

Click OK.

See Also

See “Understanding File Formats” on
page 381 for information on some of the
various file formats available in
Photoshop.

Preferences

General File Saving Options

Image Previews: | Always Save 3
M icon [ Full Size
¥ Macintosh Thumbnail
¥ Windows Thumbnail
Append File Extension: [ Always 3]

™ Use Lower Case

Type File Compatibility

¥ Prefer Adobe Camera Raw for Supported Raw Files
[lignore EXIF profile tag

¥ Ask Before Saving Layered TIFF Files

Maximize PSD and PSB File Compatibility: [ Ask | %]

Version Cue
™ Enable Version Cue

Recent file list contains: |10 | fileS

OK
( Cancel )
C Prev )
€ Next )

Chapter 3  Customizing the Way You Work
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Working with
Interface Preferences

Adobe
Certified| PS11,1.2
Expert

Work with Interface Options

Click the Edit (Win) or Photoshop
(Mac) menu, point to Preferences,
and then click Interface.

Select the Interface options:

Screen Modes. Choose
background and border colors
for the three screen modes.

Use Grayscale Application
Icon. Shows the application
icon in grayscale or color.

Show Channels In Color.
Allows you to view channels in
the Channels panel in color.

Show Menu Colors. Displays
menu items in user-defined
colors.

Show Tool Tips. Shows labels
when your cursor is placed
over an option.

Auto-Collapse Iconic Panels.
Automatically collapses icon
panels when you click away.

Remember Panel Locations.
Saves the panel locations.

Auto-Show Hidden Panels.
(New!) Hidden panels will
temporarily appear when you
move your cursor to the edge
of the application window.

Ul Text Options. Click the Ul
Language list arrow to choose
a default language, and then
click the Font Size list arrow to
select a size for interface fonts.

Click OK.

58

Working with the Interface preferences gives you control over whether
Photoshop displays or hides user interface features. You can display
some user interface elements in color. For example, you can show the
Application icon in color or grayscale, show channels in color, or show
selected menu items in user-defined colors. Interface preferences also
allow you to show descriptive labels when your cursor is placed over
an option, automatically collapse icon panels when you click away, and
remember panel locations for the next use. You can also change the
size of the text font on the Options bar, panels, and tool tips.

Preferences.

Ceneral General oK
Intertace Color Border fm\
File Handing Standard Screen Mode: | Gray +) [ Drop Shadow 13 e
s Full Screen with Menus: | Gray +) [ Drop Shadow [+] r:ri\
I G Full Sereen: [ Black +] [None +) e
Units & Rulers "] Use Grayscale Application lcon

Guides, Grid & Slices "] Show Channels in Color

Plug-lns M Show Menu Colors

Type

[ Show Tool Tips

Panels & Documents
[] Auto-Collapse Icanic Panels

[ Auto-Show Hidden Panels

¥ Remember Panel Locations

[] Open Documents as Tabs

[ Enable Floating Document Window Docking

Ul Text Options.

: (English T8
Ul'Language: | English 15] - changes will take effect the next
Ul Font Size: [Small _[&] = time you start Photoshop.



Working with Cursors
Preferences

Work with Cursors Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Cursors.

Select the Painting Cursors
options you want to use:

Standard. Painting cursors look
like their toolbox icons.

Precise. Painting cursors
appear as crosshairs.

Normal Brush Tip. Painting
cursors appear with the shape
of the active brush tip.

Full Size Brush Tip. Shows the
full size of the brush tip,
including feathered edges.

Show Crosshair In Brush Tip.
Displays a crosshair in the
center of the brush tip.

Select the Other Cursors options
you want to use:

Standard. Painting cursors look
like their toolbox icons.

Precise. Painting cursors
appear as crosshairs.

Brush Preview. Choose a color
for brush editing preview.

Click OK.

We communicate with Photoshop using various devices, such as a
drawing tablet, mouse, touch screen, track pad, or keyboard.
Photoshop communicates with us using visual cues, the most promi-
nent one being the shape of the cursor. For example, when a cursor
looks like an I-beam, this typically means it's time to enter text, or when
the cursor looks like a magnifying glass, clicking on the image expands
the view size. Working with the Cursors preferences gives you control
over how Photoshop communicates with you.

Preferences

Painting Cursors Other Cursors ( oK. )
% (ﬁcanm
Prev
() Standard @ Standard ———
() Precise ) Precise
(@) Normal Brush Tip

) Full Size Brush Tip
[ Show Crosshair in Brush Tip

Next

Brush Preview

e .

For Your Information

Toggling Between Precise and Standard Tools

Pressing the Caps Lock key while using a painting cursor toggles the
tool between the precise and brush size options, and pressing the Caps
Lock key when using any other cursor toggles between standard and
precise options.

J
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Controlling
Transparency
& Gamut Preferences

Control Transparency
& Gamut Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Transparency & Gamut.

Select the Transparency Settings
options you want to use:

Grid Size. Allows you to select
a transparency grid size.

Grid Colors. Allows you to
choose the color scheme for
the transparency grid.
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The Transparency & Gamut preferences control how Photoshop dis-
plays transparent areas of a document (commonly called the checker-
board), as well as the color and opacity of areas of an image that fall
outside of the CMYK (Cyan, Magenta, Yellow, and Black) color mode.
It's important to understand that transparency in Photoshop does not
always translate into transparency after you save the file. For example,
the JPEG format is used primarily for images saved for the Internet, and
does not support transparency. When you save the file, Photoshop will
fill the transparent areas of the image with a matte color (the default is
white). In addition, the Gamut Warning may be activated because a
monitor displays color information using RGB, and has more available
saturation values than a CMYK document. Using a different ink or spot
colors can sometimes fix an out-of-gamut color. For transparency it's
important to remember that unless you're printing the document
directly in Photoshop, it's the format you choose that determines if the
transparent areas will be saved, and the Gamut Warning is there to
warn you of any areas that may not print the way you expect.

Preferences

General Transparency Settings ok )
Grid Size: | Medium % | m——
Grid Colors: ([ Light % | —r—
Next
Gamut Warning
Tige Color: Opacity: [100 [#] %



Select the Gamut Warning options
you want to use:

Color. Choose a color to mask
areas of an image that move
out of the CMYK color space.

Opacity. Enter a value from 0%
to 100%.

Opacity determines how much
of the Color Overlay masks the
original image pixels.

For example, if you choose the
color gray, and an opacity of
100%, areas of an image that
fall outside of the CMYK color
space will be masked with

gray.
Click OK.

IMPORTANT To activate the
gamut warning option, open a
document in Photoshop, click the
View menu, and then click Gamut
Warning. Out of Gamut areas of
the image will display with the
color and opacity chosen in the
Transparency & Gamut
preferences.

Preferences

Transparency Settings

Grid Size: [ Medium %
Grid Colors: [ [ Light |+

Gamut Warning

oo .

e
(" Cancel )

Prev

Next

Opacity: [100 [#] %

Chapter 3

Customizing the Way You Work

61



Working Wlth Units While changing the measurable units and rulers do not affect output

quality, they do help to measure information in a document consistent
& Rulers with the specific output device. Ruler Units give you precise informa-
tion on the width and height of the active document. The Column Size
measurements provide information that Photoshop needs to create
documents with columns, such as newspapers, magazines, brochures,
etc. The New Document Preset Resolutions area lets you select spe-
cific resolution values when creating new documents. Insert the values
you'll use most often in the creation of a new Photoshop document.

Work with Units & Rulers
Options
Click the Edit (Win) or Photoshop e
(Mac) menu, and then point to nits pr—
Preierences. '”‘::;m Rulers: | inches | & T m——
Performance Type: | points |4 Prev
Click Units & Rulers. O e | | Column iz e )
Uni Width: | 180 | points %]
Select the Units options you want Guter:[12 [ points %]
to use: Tree New Document Preset Resolutions
Print i 300 | pixels/inch |4
Rulers. Sets a default Screen Resolution: [72 | pixels/inch %)
measuring system for the Point/Pica Size
Ruler bar ) PostScript (72 points/inch)

() Traditional (72.27 points/inch)

For example, pixels would be
most common for images
displayed on a monitor, and
picas or inches most common
for output to press or printer.

Type. Use to measure type with
pixels, points, or millimeters.

Did You Know?

You can switch between ruler meas-
urements without going to
Preferences. To change the default
measurement system of the Ruler bar,
simply move into the Ruler bar, and
then right-click your mouse. A list of
available measurement options will be
instantly available.
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Select the Column Size settings
you want to use:

Width. Choose a measurement
system and numerical value for
column width.

Gutter. Choose a measurement
system and numerical value for
gutter (the space between the
columns).

When you choose a
measurement system (points,
inches, or centimeters),
Photoshop changes the value
to correspond to the type of
measurement system.

Select the New Document Preset
Resolutions settings you want to
use:

Print Resolution. Select a print
resolution and measurement
value for default printing.

Screen Resolution. Select a
print resolution and
measurement value for default
screen display.

Click the PostScript or Traditional
option measuring systems for
Photoshop's type tool (PostScript
is the most widely used).

Click OK.

Preferences

General
Incerface

File Handling
Parfarmance
Cursors
Transparency & Gamut
Units & Rulers

Cuides, Grid & Slices.
Plug-ins

vee

Units

Rulers: | inches -
points | &

Type:
Column Size
Width: |180 | points |2

Gutter: |12 | points |5

New Document Preset Resolutions

Print Resolution: |300 [ pixels/inch [§
Screen Resolution: 72 | pixelsfinch |4

Point/Pica Size
® PostScript (72 points/inch)
() Traditional (72.27 points/inch)
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Working with Guides,
Grid & Slices

Work with Guides, Grid & Slices
Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Guides, Grid & Slices.

Select the Guides options you
want to use:

Color. Select a default color for
displaying guides.

Style. Select a default (Lines or
Dashed Lines) for displaying
guidelines.

Select the Smart Guides options
you want to use:

Color. Select a color for use
with Smart Guides.

Did You Know?

You can change a horizontal guide into
a vertical guide, and vice versa. Move
into the Ruler bar and drag a guide into
the document window. Before releas-
ing the mouse, hold down the Alt (Win)
or Option (Mac) key. The guide auto-
matically switches directions.
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The Guides, Grid & Slices preferences help keep a multi-layered docu-
ment in proper order. For example, using Guides can help you line up
buttons on a web interface, or make sure specific design elements are
precisely placed within the document window. The Guides option lets
you select the color and style of the guides placed within a Photoshop
document. Guides are placed within the image by dragging them from
the horizontal or vertical Ruler bars in the active document. The Grid
options let you decide on a color, style, and layout for Photoshop's grid
system. The Slices option defines the visible color of a slice, and
whether Photoshop displays a number value for each slice.

Preferences
General Guides € oKk
" . Color:[MCyan 3] ( Cancel )
rforma Style: [Lines 18 e
Transparency & Gamt Smart Guides St il
Color: ([ Magenta I+ .
Tvee Grid
Color: [ Custom %] Gridline every: |1 Cinches %] .

Style: | Lines : Subdivisions: |4

Slices

Line Color: | [ Light Blue %] ™ Show Slice Numbers




Select the Grid options you want o
to use:

Preferences

Color. Select a default color for Gz =
displaying grids. Color: (EGyan 3] ==
Style: [Limes— )

Style. Select a default style ey —_—
(Lines, Dashed Lines, or Dots) S T e
for displaying the grid. .

Tree Grid
Gridline Every. Enter a value for Color:  Custom ") Elimeemy B (inches— ) .:I_
how often the grid lines appear Sole:[Lines  [5]  subdivisions: 4
within the active document. Slices

Line Color: [ [ Light Blue 4]  Show Slice Numbers
Subdivisions. Enter a value for
how many subdivisions (lines)
appear between each main
gridline.

Select the Slices options you want
to use: e

Line Color. Select a default line
color for displaying document
slices.

Show Slice Numbers. Select
the check box to display a
number for each slice in the
upper left corner of the slice.

IMPORTANT When you select
a line color, choose a color that is
different than the grid and guide
line colors. That way you can
easily identify grids and guides for
user-created lines.

Click OK.

Did You Know?

You can change color choices for
Guides, Grid & Slices. Not satisfied
with the color choices offered by the
color and style menus? Click on the
Color boxes located on the right side of
the Preferences dialog box, and select
any color from the Color Picker.
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Selecting Plug-Ins

Work with Plug-Ins Options

66

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Plug-Ins.

Select the Additional Plug-Ins
Folder check box if you have
additional plug-ins stored outside
the default Photoshop plug-ins
folder.

IMPORTANT The first time you
select this option, Photoshop asks
you where the plug-ins are stored.

If you change the location of your
additional plug-ins folder, you can
always click Choose and navigate
to it.

Choose options for Extension
Panels. (New!)

Check Allow Extensions to
Connect to the Internet and/or
Load Extension Panels if you want
to use new features such as Kuler
or Connections. (New!)

Click OK.

The Plug-ins preferences give you the ability to organize your plug-ins
by saving them in one or more folders. These additional folders are typ-
ically used to hold third-party plug-ins. When selected, plug-ins con-
tained within the folder will be available from Photoshop's Filter menu.
Organizing your plug-ins into folders helps keep your projects focused
and reduces the clutter of plug-ins when you select them from the Filter

menu.

Preferences

1
™ Additional Plug-Ins Folder
TaPRoroshop:Plug- s

Extension Panels
¥ Allow Extensions to Connect to the Internet
M Load Extension Panels

1 Changes will take effect the next
“< time you start Photoshop.

Choose...

o)
(am———




Selecting Scratch
Disks

Work with Scratch Disks
Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Performance.

Select the check box next to the
scratch disk you want to use or
clear the check box to remove it.

IMPORTANT Photoshop holds
scratch disk space as long as the
application is open. To delete
scratch disk space you must close
Photoshop.

Click OK.

The Performance preferences are available to help you get the best
performance out of your computer by letting you choose one or more
hard drives for scratch operations. When your computer doesn't have
enough RAM to perform an operation, Photoshop uses free space on
any available drive, known as a Scratch Disk. Photoshop runs faster
when you divide the Scratch Disk workload. Scratch operations are
performed on your hard drive and take place when Photoshop is using
one of its many filters and adjustments. Photoshop detects and displays
all available disks in the Performance preferences dialog box, where
you can select the disks you want to use. By assigning additional hard
drives to the task, you speed up Photoshop's overall performance.
Scratch Disk changes take effect the next time you start Photoshop.

Preferences.

General Performance oK

Interface Memory Usage History & Cache ——

" Available RAM: 1963 M8 History Stares: 20 9] |
- rev
Ideal Range: 1079-1413 MB Cache Levels: |4 D T

Transparency v & Gamut Let Photoshop Use: 1374 MB (70%) —

Units & Rulers =

Cuides, Grid & S| s

Pt Scratch Disks GPU Settings

‘ |Aﬂwe> ‘D'lv‘e Free Space Information ‘ Detected Video Card:
 Macinas| hHD  23.21CE

Enable OpenGL Drawing
Advanced Settings

Description

Amount of memory assigned to Photoshap. Changes wil take effect the next time you start Phososhep.
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Allocating Memory &
Image Cache

Adobe
Certified| PS 13
Expert

Allocate Memory & Image
Cache Options

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to
Preferences.

Click Performance.

Select the History & Cache options
you want to use:

Cache Levels. Select a number
from 1 to 8.

History States. Enter the
amount of History States steps
you want to keep as undos; you
can enter up to 1,000.

IMPORTANT History States
impact Photoshop's performance
by holding the History States using
a combination of RAM and
Scratch Disk space. The more
History States used, the more RAM
is required. Using an extensive
number of History States can
impact Photoshop's performance.

See Also

See “Installing Photoshop,” on page 2
for information on RAM and other sys-
tem needs.
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The Memory Usage and History & Cache preferences give you control
over how much RAM is assigned to Photoshop, and how much memory
is allocated to screen redraws (Image Cache). Photoshop, being a high-
performance application, requires a fairly large amount of RAM.
Adjusting these options can help increase Photoshop's overall speed
performance. Photoshop uses many operations that affect RAM:
History States, Undo, Clipboard, and Cache. When you modify the
Memory Usage settings, you are increasing or decreasing the amount
of RAM Photoshop uses for various tasks. Experimentation is the key
here. Try different settings and record Photoshop's performance. By
fine-tuning Photoshop's engine, you increase its overall speed, and
you'll get more design miles to the gallon.

Preferences

o)

Ceneral Performance

eterface Memory Usage
Available RAM: 1963 M3
Ideal Range: 1079-1413 M8
Let Photoshop Use: [1374 MB (70%)

=

Scratch Disks

[ [eer [orie Feespce [ilormaton |

History & Cache
History States: 20

(2] (3]

Cache Levels: 4

L

GPU Settings
Detected Video Card:

Enable OpenCL Drawing

Advanced Settings

Description

Amount of memary assigned to Photashap. Changes will take effact the next time you start Phatashop.

For Your Information

Setting the Cache Levels

Cache Levels are screen redraws, or how many versions of the cur-
rent active document Photoshop saves. When you're working on
large documents, more Cache Levels help speed up the redraw
function, and make image manipulation proceed faster. However,
they are held primarily in RAM, so the more Cache Levels you
choose, the less RAM is available for other Photoshop functions.
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Enter the percentage of RAM used
in the Let Photoshop Use box.

Photoshop needs about 5 times
the size of the open document of
unused RAM to operate efficiently.

IMPORTANT Any changes
made for allocating memory and
image caching will take place the
next time you start Photoshop.
Please see the message at the
bottom of the screen.

GPU Settings (New!). If you have
a video card installed with a GPU
(Graphics Processing Unit), the
name of your video card will
appear under Detected Video
Card. Check Enable OpenGL
Drawing (GL stands for Graphics
Library) to make the enhanced
speed and smoothness of CS4
graphic rendering and navigation
available to you.

Click OK.

IMPORTANT Never select
100% Memory Usage. Selecting
100% gives Photoshop your entire
available RAM, leaving nothing for
the operating system or any other
open programs. If you are
experiencing more than your usual
share of Photoshop crashes,
experiment with reducing memory
usage.

Preferences.

Performance ol )
Memory Usage History & Cache = Garcel=4
Available RAM: 1963 MB History States: |20 v Pi
5 rev
Ideal Range: 1079-1413 MB (s |0 D e )
Let Photoshop Use: | 1374 MB (70%) T e
=
&
Scratch Disks GPU Settings
[ [Activer Jorive Free Space Information | Detected Video Card:
1 #  MacimoshHD  23.21CE

H
3

Description

Amount of memary assigned to Photoshop. Changes will take effec the next time you start Photoshap.

Chapter 3
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Working Wlth Type Although Photoshop is not by definition a typesetting application, such

as Adobe InDesign, it does have some very powerful type features. For
example, Adobe Photoshop allows you to output PostScript text to a
printer with a PostScript option. This way you will not need to place
Photoshop images into type-intensive applications, such as InDesign or
Illustrator, just to create a few lines of text. In addition, Photoshop's
type menu lets you see fonts exactly as they will print or display. For
designers who use a lot of fonts, this WYSIWYG (What You See Is What
You Get) font menu is a timesaver. You can use Type preferences to
help you select the type and font options you want to use.

Work with Type Options

10

Click the Edit (Win) or Photoshop
(Mac) menu, and then point to

Preferences

Preferences. i
Ceneral Type Options OK
Interface ¥ Use Smart Quotes )
. Cancel
ClICk Type Fie Handling ["]Show Asian Text Options —
# Enable Missing Glyph Protection J——ire—
¥ Show Font Names in English ( Next )

Select the Type options you want
to use:

™ Font Preview Size: | Medium

Use Smart Quotes. Select to
use left and right quotation
marks.

Show Asian Text Options.
Select to display Japanese,
Chinese, and Korean type
options in the Character and
Paragraph panels.

Enable Missing Glyph o
Protection. Select to

automatically select incorrect,

unreadable characters

between roman and non-roman

(Japanese or Cyrillic) fonts.

Show Font Names In English.
Select to display non-roman
fonts using their roman names.

Font Preview Size. Select to
display fonts on the menu in
small, medium, or large size.

Click OK.

IMPORTANT Photoshop uses
PostScript measuring systems to
size fonts. Therefore a 72-point
font will print 1 inch tall. This lets
you know how big the fonts will
appear when output to print.



Managing Libraries
with the Preset
Manager

Create a New Preset

Click the Edit menu, and then click
Preset Manager.

Click the Preset Type list arrow,
and then select the options.

Click the Options list arrow, and
then select from the available
presets to add them to the current
item list.

To remove any items in a new
preset, click a thumbnail, and then
click Delete.

To reorganize their order, click and
drag the thumbnails to new
positions within the view window.

To change a preset name, click a
thumbnail, click Rename, change
the name, and then click OK.

Click a thumbnail, and then click
Save Set.

Enter a new set name, and then
select a location to store the set.

Click Save, and then click Done.

Did You Know?

You can save specific items in the
view window as a preset. Press
Ctrl+click (Win) or [z s+click (Mac) on
only those items you want in the new
set, and then click Save Set.

The Preset Manager gives you one place to manage brushes,
swatches, gradients, styles, patterns, contours, custom shapes, and
preset tools. The Preset Manager can be used to change the current
set of preset items and create new libraries of customized sets. Once a
library is loaded in the Preset Manager, you can access the library's
items in all locations where the preset is available. Changes made in
the Preset Manager are global and are applied every time you open
Photoshop. When you save a new preset, the name appears in the
dialog box for the specific option you selected.

Pfeset Manager
Preset Type: | Brushes | VW Kz! 0
—_— it ( Done ')

. ® - . - - - .
1 3 H a 13 19 s 9 13 17 21 27 35 45 Load...
% % % o 0@ + & = w|w g
(3 100 200 | 300 9 13 19 17 45 65 !C-U 200 | 300 14 Save Set...
XL TR IEE
24 27 39 45 £ 11 17 23 36 44 60 14 26 13 s Rename >
‘ . PRl iy e [ e —
’] 5 70 11, 134 74 a5 29 192 36 36 a3 63 3 S Delete )
E L - . .- = —
33 63 11 48 32 55 100 75 45 | u
Save
Save brushes in:
Save As: AdditonalShapes.abr E]
Where: | [ Brushes =
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Customizing the
Workspace

Adobe
Certified| PS 11
Expert

Create a Customized Workspace

Arrange the panels into a specific
working order.

Click the Window menu, point to
Workspace, and then click Save
Workspace.

Type a name for the workspace.

Select check boxes to save Panel
Locations, Keyboard Shortcuts, or
Menus.

Click Save.

Delete a Customized Workspace

Click the Window menu, point to
Workspace, and then click Delete
Workspace.

Click the Werkspace list arrow, and
then click the workspace you want

to delete, or click All.

Click Delete, and then click Yes to
confirm the deletion.

Did You Know?

You cannot delete the Workspace in
which you are currently working. You
must switch to another workspace first.

12

The Photoshop workspace consists of a document surrounded by an
Application frame (Mac only), Application bar, Options bar, toolbox, and
over 20 floating panels, including new 3D, Adjustments, Masks, and
Notes panels (New!). Depending on how you work, your workspace
may reflect any combination of the above. For example, when you work
with text, you would need the Character and Paragraph panels, but you
might not need the Styles or Histogram panel. To work efficiently, each
job requires a specific organization of the workspace. Rather than mak-
ing you redesign your workspace every time you begin a new project,
Photoshop gives you ways to create and save your own customized
workspaces.

Save Workspace

Name: |Untitled-1 (T)—e

Capture ~ Cancel
@ Panel Locations
"1 Keyboard Shortcuts

[ Menus

Delete Workspace

Workspace: | [TB Basic =% 1 r Delete w

For Your Information

Resetting Panels

You can reset all Photoshop panels back to their original configura-
tions. Click the Window menu, point to Workspace, and then click

Essentials (Default) Workspace to reset all panel locations and menus.j
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Defining Shortcut
Keys

Adobe
Certified| PS 11
Expert

Create a Keyboard Shortcut

Click the Edit menu, and then click
Keyboard Shortcuts.

Click an arrow (left column) to
expand the menu that contains the
command for which you want to
create a shortcut.

Select an item from the Commands
list.

Use the keyboard to create the
new shortcut. For example, press
Ctrl+N (Win) or (z)+N (Mac).

Click Accept.
Click OK.

Did You Know?

You can save time using shortcut keys.
According to several time and motion
studies, using shortcut keys can actu-
ally save a computer user 1 hour out of
every 8 in a work day.

A wise man once wrote "time is money," and Photoshop is a program
that can consume a lot of time. That's why the Photoshop application
uses keyboard shortcuts. Keyboard Shortcuts, as their name implies,
let you perform tasks in a shorter period of time. For example, if you
want to open a new document in Photoshop, you can click the File
menu, and then click New, or you can abandon the mouse and press
Ctrl+N (Win) or (zs=+N (Mac) to use shortcut keys. Using shortcut keys
reduces the use of the mouse and speeds up operations. In fact, a
recent study in the American Medical Journal suggested that the use
of shortcut keys significantly cuts down on repetitive stress, and
reduces instances of carpal tunnel syndrome. Photoshop raises the bar
by not only giving you hundreds of possible shortcut keys, but also
actually allowing you to define your own shortcuts.

Keyboard Shortcuts and Menus

NS J

Keyboard Shortcuts “WERUSIN
set: [ Photoshop Defaults ) [ B Cancel

Shertcuts For: | Application Menus =)

Application Menu Command | shortcur Accept .40
Save As... Shift+3+5 -

Undo
Opt+3+5

Use Default

Check In... J— Q Y

Save for Web & Devices... Opt§shift+38+S Add Shortcut
Revert G ( Delete Shortcut )
Place...

mpore (" Summarize... )

Variable Data Sets... s

N Video Frames to Lavers... b

1 To edit keyboard shortcfts

>/ 1) Click on the New Set Button to create § copy of the selected set, or select a set to modify.
2) Click in the "Shortcut]column for a cofimand and press the keyboard shortcut to assign.
3) Save the set when yo are done editin to save all your changes.

For Your Information

Working with Shortcuts

In addition to adding shortcuts, you can delete any of them you don't
want and even print out a summary of shortcuts defined in
Photoshop. Shortcuts can be used for the Application and Panel
menus, as well as for your tools in the toolbox. Click the Edit menu,
click Keyboard Shortcuts, and then use the appropriate buttons,
such as Add Shortcut, Delete Shortcut, or Summarize, to perform the
tasks you want.
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Creating a Customized

User Interface

Adobe
Certified| PS 11
Expert

Use a Predefined User Interface

Click the Window menu, and then
point to Workspace.

TIMESAVER Click the
Workspace menu (New!) (which
displays the name of the current
workspace) on the menu bar.

Click one of the predefined sets,
such as: Automation, Web,
Painting, or What's New in CS4.

If prompted, click Yes to apply the
changes.

The Photoshop menus will now
display with highlighted options
based on your selection.

Did You Know?

You can restore menus to the original
settings. To restore all of the
Photoshop menu settings to the origi-
nal values, click the Window menu,
choose Workspace, then scroll to the
bottom and choose Keyboard
Shortcuts & Menus. From there, you
can choose Photoshop Defaults in the
Set drop-down menu to revert to
default menus.
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Photoshop's pull-down menus actually contain hundreds of options
(yes, | did say hundreds). If you find navigating through menus a hassle,
then Adobe has the answer to your problem with a customizable user
interface. In Photoshop, you have the ability to choose what menu
items appear on the pull-down menus and you can even colorize cer-
tain menu items for easier visibility. For example, if you're curious about
all the new features in Photoshop CS4, you can choose a drop-down
menu system with all the new features highlighted. Photoshop includes
nine predefined user interface sets, known as workspaces, just to get
you started in the right direction. You can access these workspaces—
such as Essentials, Basic, and What's New in CS4—by using the
Workspace menu (New!) on the Application bar or Workspace sub-
menu on the Window menu.

v Essentials (Default) —

Extensions » pasic
What's New in CS4
3D
Actions Fo Advan[led b
N Analysis
Adjustments -
3 ; Automation _t’
Animation
Color and Tone
Brushes F5 i
Painting
Channels :
Proofing
Character T h
Clone Source LR
Video
Color F6
; Web
Histogram 1
History Save Workspace...
Info 8
Layer Comps
v Layers 7 Keyboard Shortcuts & Menus...
« Masks
Measurement Log
Navigator
Notes
Paragraph
Paths
 Styles
Swatches
Tool Presets
| ESSENTIALS * Workspace menu
Application Frame 3
Ieat
+ Application Bar Basic
v Options What's New in CS4
v Tools
Advanced 3D
Analysis
Automation
Color and Tone
Painting
Proofing
Typography
Video
Web

Save Workspace...



Create a Customized User

Interface 0 O 0

Cth the Wil'ldOW menu, pOint to Keyboard Shoftcuts and|Menus N
Workspace, and then click A =
Keyboard Shortcuts & Menus. . (Frotoshon DefatTs | - Cana )
Click the Menus tab. T e e serery ——
Application Menu Command Visibilif Color
To create a new set based on the = v | B
current active set, click the Create New... None
New Set button, enter a name, and s Shoe
- Browse... None

then ClICk save' Open As Smart Object... None

. . ‘Open Recent> None
Click the Set list arrow, and then T = L
select a listing of modified User || o~ e 1
Interfa ces. \i/ :l)iqr?:ir;rr:ie:ﬂim;‘ click on the Visibility button.

2) Show All Menu Items will be appended tofthe bottom of a menu that contains hidden items.

2 2 3) To temporarily see hidden menu items, clck on Show All Menu Items or # + click on the menu.
Click the Menu For list arrow, and
then click Application Menus or T i et s s e ik s ot et

. . 2) To turn off menu colors, go to the Generd Preference panel and hincheck Show Menu Colors.

Panel Menus with the items you
want to modify.
Click an arrow (left column) to

expand the menu that contains the
command you want to modify. 0

Click the Visibility icon associated
with a command to show or hide

the command. o @

Click the Color list arrow, and
select a color for the selected

Keyhoard Shortcut} and Menus ]

mmand — o
CO a ' Set: Photoshop Defaults }%J A @ Cancel

Click the Save All Changes button

: Menu For: | Application Menus )
to save the new customized User

Application Menu Command ‘ Visibility | Color
Interface. v Fie 0
New... None
Click OK. [Gowe )
Browse... None
Open As Smart Object... None
‘Open Recent> None
Clear Recent None .
- v
Did You Know? — -

. \i/ T)iid:;y:rr:le:;ﬂ;m; click on the Visibility button.

You can delete a user interface set. S o T e
Click the Windows menu, point to e

Workspace, click Keyboard Shortcuts 2 Ta turh off mems cotere. o e the Ceneea Preference panel and uncheck Show Menu Calors
& Menus, click the Menus tab, click

the Set list arrow, click the set you

want, and then click the Delete button.
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Using Drawing Tablets

When you design on a computer, you're leav-
ing the natural world of oil, watercolor, and
canvas, for the electronic world of computer
monitors and pixels (don't worry, it's a rela-
tively painless transition). Without a doubt,
there are many differences between tradi-
tional and digital design; however, it's not
necessary to abandon all aspects of the natu-
ral media world. For example, the computer
mouse has always been a problem with
designers who miss the feel and control of a
brush in their hands. Fortunately, technology
came to the rescue several years ago, with
the invention of the drawing tablet. Drawing
tablets combine a drawing surface and a
brush-like drawing tool in the form of a pen.
A designer picks up the pen and moves it
across the drawing tablet surface. In turn, the
drawing tablet interprets those movements
as brush strokes. Not only does Photoshop

fully support drawing tablet technology, it
also interprets the particular drawing style of
the designer. For example, pushing harder
with the brush against the drawing tablet
instructs Photoshop to create a wider stroke,
or to apply more color. Drawing tablets have
helped to translate the control of working
with real art brushes on canvas, into the
world of the digital designer. Of all the manu-
facturers, Wacom stands out as the leader in
drawing tablet technology. Wacom returns the
feel of designing with a brush to the digital
designer's world, and the software required
to power the tablet works seamlessly with
Photoshop and the Windows or Macintosh
operating systems. To check out which tablet
might be right for your needs, point your
browser to www.wacom.com and check out
the available options.

Wacom tablet

Drawing pen
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A

absolute colorimetric rendering intent, 419
accented edges filter effect, 345
Acrobat 4 color system, 422
Acrobat ConnectNow, 499
actions, 347-368. See also droplets
adding command to action, 354
buttons, converting to, 349

Conditional Mode Change command,
400

copying, 358

sets, copying between, 362
deleting command from action, 355
enhanced scripting of, 364-365
files, saving actions as, 361
modal controls, working with, 356
moving actions between sets, 362

multiple sources, calling actions from,
359

names for action sets, 362
new action, building, 350

non-recordable commands, inserting,
363

order of commands, changing, 357
pauses in, 356
play options, 366
playback of command, controlling, 353
recording actions, 351
running actions inside actions, 359
saving, 347
files, saving actions as, 361
sets, saving actions into, 360
sets
creating, 360
files, saving actions as, 361
moving and copying between, 362
names for, 362
speed of executing, 357

stop to action, adding, 352
Actions dialog box, 361

Actions panel, 347-349. See also
actions; droplets

Add Layer Mask button, 233, 235
with type masks, 317
Add Layer Styles button, 235, 275, 290
Add New Layer button, 101
Add Noise filter, 146
Additional Plug-Ins Folder, 66
Additive RGB, 172
adjustment layers, 99
advantages of, 135
blending modes with, 142
composite layers, creating, 139
creating, 136
deleting, 141
file formats for, 136
filters on masks, 145
grouping, 140
Levels adjustment for, 164-165
linking layers in, 111, 139
masks with, 144-145
merging
with images, 138
temporary composite images,
creating, 139
modifying, 137
opacity, working with, 142
pain on adjustment masks, 144
regular layer, converting to, 141

temporary composite images, creating,
139

Adobe (ACE) color management, 426
Adobe Acrobat Connect, 488, 497
Adobe Acrobat Reader, 4
Adobe Bridge. See Bridge
Adobe Creative Suite, 1, 488

Bridge with, 13
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Adobe Device Central, 488, 500-501
Adobe Drive, 488

Adobe Extension Manager, 488, 502
Adobe Flash. See SWF files

Adobe Gamma utility, 414

Adobe Help Center, 4, 26-27

Adobe lllustrator. See lllustrator

Adobe Updater Preferences dialog box, 4,

24-25
Adobe Version Cue, 1, 488
Airbrush, 159, 213, 214
align layers, Auto, 474-475
alpha channels

different file formats, saving documents

as, 383
saving, 28

altitude values for Bevel and Emboss
style, 279

anchor points. See also paths
with Magnetic Lasso tool, 83
angle values
for Bevel and Emboss style, 279
for Drop Shadow style, 276
with Smart Sharpen filter, 156
animations, work with, 452-453
animated GIFs
creating, 450-451
annotations. See notes
anti-aliasing, 213
for Bevel and Emboss style, 280
Character panel selections, 301
Column Marquee tools and, 80
with Custom Shapes tool, 220
for Drop Shadow style, 277
for Inner Glow style, 289
with Line tool, 217
and Magic Eraser tool, 226

multi-page PDFs to PSDs, converting,
403

for Outer Glow style, 287

with Paint Bucket tool, 223

for paths with fill, 268

setting options for, 303

with Type tool, 297, 299
Apple Computers. See also Macintosh
Arc and Arch styles of warped text, 304
arrange

multiple documents, 42

arrowheads with Line tool, 217
Art History brush, 121, 132
artistic filters, 320

for layer mask borders, 239
Asian text options, 70
Auto-Align, 474-475
Auto-Blend, 474-475
Auto Color command, 191
Auto Contrast and Color command, 167
Auto Contrast command, 191
Auto Erase, 216
Auto levels command, 190
Automate commands, 397-412

Background Eraser tool, 224-225
backgrounds, 99, 206-207
converting into layers, 106-107
default and switching of colors, 207

Foreground and Background colors,
206-207

Merge Visible option, 107

multi-layered documents into back-
grounds, converting, 107

Screen Mode determining, 37
Barrel distortion, 150-151
baseline shift, 295
Character panel selections, 301
batch commands with Bridge, 410-411
Batch File Processing, 398-399
BBEdit, 364
Bevel and Emboss style
contours, working with, 279-280
with layer masks, 235
Texture option for, 280-281
with type masks, 314-315
working with, 278-279
Bicubic Sharper method, 54
Bird’s Eye view, 38-39
bit depth, 168
bitmap color modes, 171, 175
bitmapped fonts, 299

black and white. See also Grayscale
color mode

Threshold adjustment for, 203
Black & White adjustment, 204
Black Point Compensation



for converting color space, 427
for soft-proof colors, 416
blade curvature with Lens Blur filter
option, 333
blend modes, 09
with adjustment layers, 142
Color Overlay style with, 282
for Drop Shadow style, 276
Fill blending mode, 187
for Inner Shadow style, 288
with layer masks, 237
with layers, 112
for Outer Glow style, 286
with Pattern Overlays, 284
for Stroke layer style, 283
blend layers, Auto, 474-475
bloating with Liquify, 324
Blur filters. See also Lens Blur filter
Box Blur filter, 152
channel masks, softening effects of, 247
in Quick Mask Mode, 251
Shape Blur filter, 152-153
Surface Blur filter, 152-153
vignettes, creating, 238
BMP files, 381
layers exported as, 117
borders
Auto Color command with, 191
channel mask borders, moving, 248
layer mask borders, creating, 239
paths, creating shapes as, 270
boundaries, proportional transform, 94
bounding boxes, 238
clipping paths and, 266
in Print dialog box with preview, 373
Show Bounding Box check box, 372
Box Blur filter, 152
Bridge, 1, 4
automating, tasks, 498
camera raw, 492-493
closing documents and opening, 31
exploring, 489
images, working with, 494-495
opening files with, 16
photos, getting, 491
preferences, 496-497
starting, 490
with Adobe Creative Suite 2, 13, 423

brightness. See also HSB (hue,
saturation, brightness)

with Lens Blur filter, 333
Brightness/Contrast adjustment, 167, 192
Brush font, 286
brush strokes filters, 320

in Quick Mask Mode, 251
brush tips, 210

cursor options, 59

customized brush tips, creating, 211

saving, 212
brushes, 205. See also specific tools

with Color Replacement tool, 230

Liquify tool option, 326

in Quick Mask Mode, 250

with Vanishing Point tool, 148
Brushes Options menu, 212
Brushes panel, 208

modifying, 209

pre-defined sets in, 210
built-in scripts, 365
Bulge style of warped text, 304
Burn tool, 159

c

cache preferences, 53
setting levels, 68
calibrating colors. See color management
calligraphy lettering, Pencil tool for, 215
Camera Data 1 and 2, 384
Camera Raw
dialog box, 18-19, 492-493
preferences in Bridge, 492
preferences in Photoshop, 57
center justification, 299
chain button with layer masks, 233

channel masks, 231. See also Quick
Mask Mode

combining, 249

deleting, 246-247

filter effects, controlling, 340-341
Gaussian Blur filter with, 247, 249
loading, 246-247

modifying options, 242

moving masks between documents, 248
from native color channels, 244-245
pre-existing channels, options, 242

Index
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channel masks (continued)
saving, 246-247
from scratch, 241
from selections, 243
showing/hiding, 241
softening effects of, 247
working with, 240
Channel Mixer adjustment, 197
channels, 167. See also channel masks
Channel Mixer adjustment, 197
8-bit channels, 168-169
Spot color channels, 188
Channels panel. See also channel masks
selections, creating, 92
working with, 170
Character panel, 72, 295
showing/hiding, 299
Character panel
working with, 300-301
Chisel Hard Technique for bevel, 278
chiseled text
creating, 288
with type mask, 314-315
choke value for Inner Glow style, 289
chromatic aberration, 150
circles with Standard Shape tool, 218
clipart for Web, preparing, 388-389
clipboard
with Pattern Maker filter, 336
preferences for, 55
clipping. See also paths
masks, creating, 101
with Variations adjustment, 189
Clone Stamp tool, 158, 481
Clone Source panel, 160, 162, 481-482
closing documents, 31

CMYK (cyan, magenta, yellow, black) color,
13, 47, 171. See also color manage-
ment; out-of-gamut

Color Slider, 182
converting images to, 173

Multi-Channel color mode, converting
images to, 180

patterns, generation of, 337
press, preparing images for, 392-393

RGB (red, green, blue) color and, 171,
418

soft-proof colors, setting up, 416-417

Spectrums or Ramps, 183
Color Balance command, 167, 192-193
Color Dynamics, 208, 213

Color Intensity with Match Color
adjustment, 195

color lookup table (CLUT), 176-177

color management, 413-433. See also ICC
Profile; out-of-gamut; rendering intent

converting color space to profile,
426-427

different profiles to document,
assigning, 425
defaults, 422-423
hardware, calibrating with, 415
monitors, calibrating, 414
RGB to CMYK, changing from, 418
soft-proof colors, setting up, 416-417
software, calibrating with, 415
target images, printing, 428
working with, 422-423
Color Management button, 374
color markers, creating, 46
color modes, 13, 171
bitmap color modes, 175
changing, 171
Replace Color command, 181
selecting, 13
Color Overlay, 273
applying, 282
Color panel, 182-183
for PNG-8 documents, 446
Color Picker
selecting colors from, 65
text color, changing, 297
Color Replacement tool, 230
color sliders, 182
preferences for, 55
Color Swatch button, 299

colors, 167. See also channels; CMYK (cyan,
magenta, yellow, black) color; color
management; Info panel; RGB (red,
green, blue) color; spot colors; tonal
values; unified color table

Auto Color command, 191

Auto Contrast command, 191

Auto levels command, 190

Background colors, 206-207

Background Eraser tool, 224-225
of brush tips, 211



Black & White adjustment, 204
Channel Mixer adjustment, 197
clipart for Web, preparing, 388
Color Balance adjustment, 192-193
Color Replacement tool, 230
Curves adjustment, 192
deleting on Swatches panel, 184
Desaturate command, 194
for Drop Shadow style, 276
Equalize command, 202
Eraser tools with, 224-225
fill colors, changing, 310
Fill command, 186-187
Foreground colors, 206-207
for GIF documents, 444
Gradient Map adjustment, 198
Grid options, 64-65
Guides option, 64-65
for Inner Glow style, 288
Invert command for, 202
levels adjustment, 190
Macintosh, printing in, 377
Match Color adjustment, 195
Navigator panel view box color, 36
of notes, 45
for Outer Glow style, 286
Photo Filter option, 199, 334
for PNG-8 documents, 446
Posterize adjustment for, 203
in Quick Mask Mode, 251
Replace Color command, 181
selection by color range, 87
Selective Color adjustment, 196
Slice option, 64-65
Stroke command, 186
Swatches panel, 184-185
text color, changing, 297
for transparency grid, 60
Variations adjustment, 189
ColorSync, 414, 426
workflow, setting, 422
color settings, 422
with Creative Suite, 423
columns and rows
ruler options, 63
Single Row/Column Marquee tools, 80
combine layers, Auto, 474-475

combining channel masks, 249
commands. See also specific commands
enhanced scripting of, 364-365
compression. See file compression
comps, layer, 116
concavity with Line tool, 217
Conditional Mode Change command, 400
Content-Aware scaling, 96, 503-505
contours
for Bevel and Emboss style, 279
for Outer Glow style, 287
working with, 280
Convert Point tool, 265
ConvertTo Mask button, 240
ConvertTo Profile command, 426
copies
different file formats, save as, 383
file copies, saving, 28
printing, 376, 378
copying. See also actions; layers
do not copy watermarks, 343
History states, 122, 127
with Vanishing Point tool, 148-149

copyrights, watermarks protecting, 319,
342-343

contours
for Drop Shadow style, 277
for Inner Glow style, 289
Count tool
counting, 470-471
preferences, 64-65
crawling marquee, 254

Create New Action button, Actions panel,
349, 350

Create New Channel button, 240
Create New Layer button, 237
duplicating layers with, 113
Create New Set button, Actions panel, 349
Create Plane tool, 148

Crop and Straighten Photos command,
397, 401

Crop command, 397

cropping selections, 91

cursors
painting cursor options, 59
preferences, 59

Curves adjustment, 167, 192
with channel masks, 245

Index
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custom preset document, creating, 12
Custom Shapes tool, 220-222
creating custom shapes, 221
saving shape sets, 222
customizing, 51. See also layer styles
brush tips, 211
color settings, 422-423
Swatches panels, 185
user interface, 74-75
workspace, 72
cutout filter effect, 344

D

data driven graphics, 464
DCS files, 381
press, preparing images for, 392-393
defaults for panels, 7-9
Delete button, Actions panel, 349
deleting. See also layers
actions, commands from, 355
adjustment layers, 141
anchor points in paths, 260-261
with Bridge, 494-495
channel masks, 246-247
customized workspace, 72
linked layers, 114
notes, 45
panels, 7-9
pixels, 44
presets, items in, 71
ruler guides, 49
Swatches panel, colors on, 184
text, 297
density option, 377, 344
depth values
for Bevel and Emboss style, 278
Lens Blur filter option, 333
for texture, 281
Desaturate command, 194
Despeckle filter, 154
destination for droplets, 367
Device Central, 500-501
DICOM files, 381
Difference Blending Mode, 142
diffuse glow filter effect, 345
digital cameras
calibrating, 415

importing raw data from, 18-19
noise from, 147

digital watermarks, embedding, 319, 342-
343

Direct Selection tool, 263

curve of segment line, changing, 265

type path, reshaping, 318
direction for Bevel and Emboss style, 278
Display preferences. See also interface
distance values

for Drop Shadow style, 277

Lens Blur filter option, 333
distortion, 320

with Free Transform command, 94

for layer mask borders, 239

Lens Correction filter and, 150-151

in Quick Mask Mode, 251

Transform command selection, 95

distribution option with Add Noise filter,
146

dithering
clipart for Web, preparing, 388
for GIF documents, 445
for gradients, 227
for Indexed color mode, 176
for PNG-8 documents, 447
for WBMP documents, 419
DNG files
information on, 493
raw images saved as, 18-19, 492-493
do not copy watermarks, 343
Dock, painting engine in, 208
docking, 6
document windows, 42
document dimensions, 30
document window, 6
moving images in, 41
Vanishing point tool, working with, 148-
149

documents. See also layers; new docu-
ments

all documents, closing, 31

backgrounds, converting multi-layered
documents into, 107

closing, 31
custom preset document, creating, 12

dragging layer thumbnails into
documents, 44



inserting
file information into, 384-385
images in, 17
New Document Preset Resolutions,
62-63
multiple, arrange, 42
organizing documents, 383
profiles, 30
saving, 28-29
sizes, 30
Dodge tool, 159
downloading
DNG converters, 19
layer styles, 292
patches, 24-25
updates, 24-25

dragging layer thumbnails into documents,
44

drawing tablets, 76
Drawing tool, 205
Drop Shadow, 274
creating, 276-277
with layer masks, 235
modifying, 276-277
droplets, 347
creating, 366-367
naming options, 367
using, 368
dry brush filter effect, 344
DSC 2.0 color plates, 188
Dual Brush, 208, 213
Duotone color mode, 171
converting images to, 179
duplicating. See copying
Dust and Scratches filter, 146

dynamic range, 168-169. See also High
Dynamic Range (HDR) images

E

Edit Plane tool, 258

editing
animated GIFs, 455
inserted documents, 17
nondestructively, 21
selections, 89

8-bit channels, 168-169
Exposure adjustment with, 201

ellipses
for layer mask borders, 239
with Standard Shape tool, 218
Elliptical Marquee tool, 79
vignettes, creating, 238
Embed Color Profile, Macintosh, 383
embedding
ICC color profiles, 424
proof profile information, 29
Emboss style. See Bevel and Emboss style
emulating color systems, 422
encoding images for press, 393
EPS files, 381
inserting images in, 17
metadata information, adding, 385
text saved as, 297
Equalize command, 202
Eraser tools, 205, 224-225
Background Eraser tool, 224-225
basic Eraser tool, 224

with Foreground and Background
colors, 206

to History brush, 133
Magic Eraser tool, 226
exact colors for Indexed color mode, 176
Exclusion Blending Mode, 142
EXIF profile tag, ignoring, 57
exiting Photoshop, 32
Export Layers To Files command, 117
exporting. See importing and exporting
exposure
controlling, 30
Exposure adjustment, 201
Extension Manager, 502
Extract, 319
eyedroppers, 87
for Background colors, 206-207
for Foreground colors, 206-207
with Save For Web command, 438
with Vanishing Point tool, 149

F
F-Stop information, 384
fades, 319

with Match Color adjustment, 195
with Smart Sharpen filter, 157
working with, 338

Index
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Feather option
with layer masks, 236
for out-of-gamut colors, 431
File Compatibility options, 57
file compression
lossy/lossless compression, 386-387
understanding, 386-387
file extensions
for droplets, 367
lowercase, saving as, 29
file formats. See also specific types

different file formats, saving documents
with, 382-383

list of, 381
understanding types of, 381
File Handling preferences, 51, 56-57

files. See also droplets; importing
and exporting

3D, 483-485
actions as files, saving, 361
File Handling preferences, 56-57
Fill command, 186-187
for paths, 253
with paths, 268
fills
colors, changing, 310
Layers panel option, 98
with Paint Bucket tool, 223
for Stroke layer style, 283

Filter Controls, Image Gallery dialog box,
320

Filter Gallery, 320-321
multiple filters, applying, 323

Filter Selection, Image Gallery dialog box,
320

filters, 319-346. See also specific types
on adjustment layer masks, 145
categories of, 320

channel masks controlling effects,
340-341

Fade command with, 338
gradient masks with, 340-341
for layer mask borders, 239
Lens Correction filter, 150-151
multiple filters, applying, 323
order for applying, 323

Photo Filters, 199, 334

in Quick Mask Mode, 251

selections, controlling filters with, 339
shortcut for reapplying, 321
various filter effects, 344-346
watermarks, embedding, 319, 342-343
Find and Replace, 295, 307
with Bridge, 494-495
Find Edges filter, 338

Fine/Coarse slider with Variations
adjustment, 189

FireWire
Scratch Disks with, 53
video preview option, 14
Fish style of warped text, 304
Fisheye style of warped text, 304
Fit Image command, 412
Fixed Aspect Ratio
with Elliptical Marquee tool, 79
with Rectangular Marquee tool, 78
Flag style of warped text, 304
Flash. See SWF files
flow
for Airbrush tool, 214
for Paintbrush tool, 214
fonts
Character panel selections, 300-301
neon effects for, 286
of notes, 45
preferences, 54
types of, 299
Type preferences for, 70
Type tool, working with, 298
foregrounds, 206-207
default and switching of, 207
with Paint Bucket tool, 223
freeform bounding box, 17
Free Transform command, 94
Freeform Pen tool, 258-259
FreeHand, moving shapes to, 221
freezing with Liquify, 325
fresco filter effect, 344
Full Screen Mode, 37
Fuzziness slider, 87

G

gamut. See also out-of-gamut
preferences, 60-61
Gamut Warning, 173, 372, 429



mask, 60-61
Gaussian Blur filter, 154
on adjustment masks, 145
with channel masks, 247, 249
with layer masks, 236, 239
Smart Sharpen filter with, 156
for vignettes, 238
General preferences, setting, 54-55
geometry
with Custom Shapes tool, 220
with Line tool, 217
paths, complexity of, 258
with Standard Shape tool, 218
GIF files, 369, 440. See also animated GlFs
creating, 450-451
clipart for Web, preparing, 388-389
compression of, 386-387
metadata information, adding, 385
opening images, 16
optimizing GIF documents, 444-445
Save For Web command with, 436
saving documents as, 28
for Web images, 435
glass filter effect, 345
Global Light option
for Bevel and Emboss style, 279
with Drop Shadow style, 276

Gloss Contours for Bevel and Emboss
style, 279

glowing edges filter effect, 345
Gradient Map adjustment, 198
Gradient Overlay, 273
Gradient tool, 11
layer masks, blending images with, 237
gradients, 205
creating, 227
customized gradients, 228-229
with filters, 340-341
for Inner Glow style, 289
for Outer Glow style, 287
pre-defined gradients, adding, 227
with Stroke layer style, 283
grain filter effect, 346
graphic pen filter effect, 346
gray. See also Grayscale color mode
with layer masks, 232, 234
Grayscale color mode, 13, 171

Channel Mixer adjustment with, 197
Color Slider, 182
converting images to, 174
Duotone color mode and, 179
patterns, generation of, 337
Spectrums or Ramps, 183
working with, 174
grid size, 64-65
transparency grid size, 60
groups
adjustment layers, grouping, 140
nested layer group, creating, 103
Guides, Grids & Slices options, 64-65
guides for 45 degree angles, 80

H

halftone screens for press images, 393
Hand tool
with Lens Correction filter, 150
with Liquify, 325
monitor, fitting image to, 40
moving images, document window, 41
with Save For Web command, 438
with Vanishing Point tool, 149
Hard Mix Blending Mode, 142
hard proofs, printing, 420-421
hardware color calibration, 415
HDV Anamorphic Pixel Aspect Ratio, 15
Healing Brush tool, 160
with Reduce Noise filter, 147, 160
height values
Fit Image command, 412
with Pattern Maker filter, 337
print size option, 373
Help menu
updates, checking for, 25
using, 26-27
hiding. See showing/hiding
High Dynamic Range (HDR) images, 168-
169
Exposure adjustment with, 201
Merge images to, 408-409
highlights
for Bevel and Emboss style, 279
with Dodge and Burn tools, 159
Shadow/Highlight adjustment, 200
tonal range, controlling, 164-165

Index
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Histogram panel, 166
for levels, 165
History brush, 121
combining with History states, 130
correcting mistakes with, 130
Eraser tool to, 133
layers with, 133
snapshots, working with, 131
History panel, 121-133. See also snapshots
linear history, 121, 124
resetting to, 134
multiple undo commands, 122
non-linear state of, 121, 124-125
purging RAM, 134
saving RAM, 127
setting options in, 122-123
History states, 52, 68
controlling, 134
duplicating, 122, 127
History brush combined with, 130
number, setting, 122
purging, 125, 134
reviewing text file, 129
saving, 128
Horizontal Type Mask tool, 311
HSB (hue, saturation, brightness)
Brightness/Contrast adjustment, 167, 192
Color Slider, 182
Hue/Saturation adjustment, 194
opacity of, 142
Replace Color command and, 181
with Variations adjustment, 189
HTML (Hypertext Markup Language) files
generating, 441
hue. See HSB (hue, saturation, brightness)
Hue/Saturation adjustment, 194
for out-of-gamut colors, 430-431
hyphenation
Character panel selections, 301
Paragraph panel selections, 302

ICC Profile
embedding ICC color profiles, 424
information, embedding, 29
for JPEG images, 443
Windows, 383

Illustrator, 208
inserting images in, 17
paths, exporting, 253, 271-272
Pen tools in, 257
scripts, using, 364-365
shapes to lllustrator, moving, 221
image cache, 51
preferences, 53
image compression, 369
Image Gallery dialog box, 320
Image menu, Adjustments option, 135

Image Preview, Image Gallery dialog box,
320

Image Processor, 410-411

image pyramid, saving, 395

images, with bit depth (8, 30, and 32), 168-
169

importing and exporting. See also paths;
SWEF files

digital camera, raw data from, 18-19
layers to files, exporting, 117

shapes to vector programs, exporting,
221

video, 466-467
Zoomify, 468
inches as measurement system, 33
Include All Subfolders command, 366
indents
Paragraph panel selections, 302
with Standard Shape tool, 219
InDesign, 70
adjustment layers, opening, 136
clipping paths in, 253
EPS documents, type information in, 297
indexed color mode, 171
converting image to, 176-177
Inflate style of warped text, 304
Info panel, 46
changing measurement of colors in, 47
color markers, creating, 46
displaying information in, 47
specific size object, creating, 46
ink density. See density
inkjet printers
getting the best results for, 394-395
resolution, understanding, 396
Inner Glow style, 288-289
Inner Shadow style, 286-287



Insert Menu command with actions, 363
inserting images in documents, 17
installing Photoshop, 2-3

intellectual property, protecting, 319, 342-
343

interface
preferences, 58
interlacing
for GIF images, 445
for PNG-8 documents, 447
for PNG-24 documents, 448

Internet. See also Web design; Web
images; Web sites

help on, 26-27
saving files for, 28
updates, checking for, 24
interpolation, 22-23, 54, 254
press, images for, 393
inverting
command, 202
Lens Blur filter option, 333
textures, 281
IPTC Contract, 384

J

Japan
color defaults, 423
text options for Japanese, 70

jitter
for Inner Glow style, 289
Liquify tool option, 326
for Outer Glow style, 287

JPEG files, 369, 381, 440
compression of, 386-387
JPEG 2000 format, 391
layers exported as, 117
metadata information, adding, 385
opening images, 16
optimizing JPEG documents, 442-443
photographs for Web, preparing, 390-391
printers, preparing images for, 395
raw images saved as, 18
Save For Web command with, 436
saving documents as, 28
transparency, support for, 60
for Web images, 435

justification
Paragraph panel selections, 302
of text, 297, 299

K

kerning, 300

keyboard. See also shortcut keys
paths, moving, 262

Kuler panel, 66

Korean text options, 70

L

Lab color mode, 13, 171
Color Slider, 182
converting image to, 178
patterns, generation of, 337
landscape orientation, 371
large files, saving, 22, 57
laser printers, preparing images for, 394-
395
Lasso Marquee tool, 81
Lasso tools. See also specific tools
Lasso Marquee tool, 81
for layer mask borders, 239
Magnetic Lasso tool, 82-83
Polygonal Lasso tool, 81-84
launching Photoshop, 4-5
Layer Comps panel, 116
layer masks, 98, 231
blending images with, 237
borders, creating, 239
creating, 233
Paint tools with, 234
role of, 232
selections generating, 235
soft transparency, generating, 236
type masks, combining with, 316-317
vignettes, creating, 238
as white, 234
Layer Properties dialog box, 115
Layer Style dialog box, 275
customized styles with, 290-291

layer styles, 273-294. See also specific
styles

adding, 275
combining layer style elements, 290
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layer styles (continued)

customized styles
with Layer Style dialog box, 290-291
with Styles panel, 292-293

to masked images, 235

modifying existing layer style, 275

moving existing layer styles, 294

names for, 291, 293

saving customized styles, 292

sharing, 293

showing/hiding, 275

single layer styles, moving, 294

understanding, 274

layers, 97-118. See also adjustment layers;

backgrounds; layer masks; layer
styles; linked layers; opacity; Type
tool

active document, adding layers to, 100

blending modes, 112

comps, creating, 116

copying, 113
elements in layers, 105

deleting, 98, 114
linked layers, 114

designation of, 99

different file formats, saving documents
as, 383

dragging layer thumbnails into
documents, 44

Eraser tools with layered documents,
224

exporting as files, 117
History brush, multiple layers with, 133
locking, 108
Magic Eraser tool with, 226
Merge options with, 110
moving, 100
documents, layers between, 109

two open documents, moving layers
between, 44

names for, 108, 115

nested layer group, creating, 103

new layers, creating, 100-101

properties, changing, 115

saving, 28

selecting layer options, 101

selecting methods, 102

selections from layers, creating, 104-105
showing/hiding, 108

Smart Objects, converting, 21
stacking order, changing, 108

two open documents, moving layers
between, 44

updating layer comps, 116
Layers panel, 98. See also layers
controlling image information with, 108
setting options, 118
thumbnail size, changing, 118
tonal range, controlling, 164-165
leading Character panel selection, 301
left justification, 299
length with Line tool, 217
Lens Blur filter
brightness with, 149, 333
Smart Sharpen filter with, 156
working with, 332-333
Lens Correction filter, 150-151
Levels adjustment, 164-165
for actions, 352
with channel masks, 245
with type masks, 313
working with, 190
libraries, Preset Manager for, 71
Line tool, 217
45 and 90 degree angles, 217
linear history. See History panel
lines. See straight lines
Link Layers option, Layers panel option, 98
linked layers, 108
with composite adjustment layers, 139
creating, 108, 111
deleting, 114
with Pattern Overlays, 285
textures, linking, 281
unlinking, 111
Liquify, 319
mask options, 328
meshes
applying, 331
creating, 330
modifying loaded meshes, 331
Show Mesh option, 329, 330
modifying images with, 324
options, working with, 326-327
saving meshes, 331
Show Mesh option, 329, 330
view options, 329



Load Mesh button, 330
loading
channel masks, 246-247
meshes, 330
localized color cluster, 87, 181
locking layers, 108
Layers panel option, 98
locking ruler guides, 49
lossless compression, 386-387
printers, preparing images for, 394-395
lossy compression, 386-387
for GIF images, 445
luminosity
with Match Color adjustment, 195
Photo Filter option, 334
LZW files
compression of, 387
printers, preparing images for, 395

M

Macintosh
color calibrator in, 414
Embed Color Profile option, 383
Page Setup in, 370
printers, preparing images for, 395
printing documents in, 376-377
Magic Eraser tool, 226
Magic Wand tool, 86
channel masks, creating, 243
Magnetic Lasso tool, 82-83
with paths, 259
Make Work Path button, 255
marching ant marquee, 252
margins
in Macintosh Page Setup, 370
Paragraph panel selections, 302
in Windows, 371

Marquee tools, 77. See also Elliptical
Marquee tool; Rectangular Marquee
tool

Lasso Marquee tool, 81

Single Row/Column Marquee tools, 80
type masks, creating, 311

with Vanishing Point tool, 148

masks, 98. See also channel masks; layer
masks; Quick Mask Mode; selections;
Type tool

with adjustment layers, 144-145

clipping masks, creating, 101
Liquify mask options, 328
Standard Mask Mode, 250
Match color adjustments, 167, 195
Mask Edge button, 236
match prints, printing, 420-421
matte option
clipart for Web, preparing, 388
for GIF documents, 445
for indexed color mode, 176
for JPEG images, 443
photographs for Web, preparing, 390
for PNG-8 documents, 447
for PNG-24 documents, 448
for Web design, 437
measurements
Rulers, 48-49
system for, 33
Measurement Log panel
counting, 470-471
taking measurements, 472-473

memory. See also RAM (random
access memory)

100 percent Memory Usage option, 69
preferences, setting, 68-69
Memory & Image Cache preferences, 68-69
menus
color preferences for, 55
customizing, 74-75
original settings, restoring, 74
Merge Down option, 110
Merge Image to HDR, 408-409
Merge Visible option, 107, 110
merging. See also adjustment layers
Merge Down option, 110
Merge Visible option, 107, 110
Photomerge, 406-407
meshes. See Liquify
metadata, 13
adding to files, 385
with Bridge, 495
matte option
for GIF images, 445
for JPEG images, 443
for PNG-8 documents, 447
for PNG-24 documents, 448
metadata, 495
Microsoft ICM color management, 426
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midtones with layers, 112, 142
with Dodge and Burn tools, 159 with Pattern Overlays, 284
Shadow/Highlight adjustment for, 200
tonal range, controlling, 164-165 N
with Variations adjustment, 189

. . . .. names. See also renaming
mirroring with Liquify, 325

for action sets, 362

mode . for animated GIFs, 450
for Airbrush tool, 214
lor. 13. 171 for custom preset document, 12
eolor = of data driven graphics, 466
Conditional Mode Change command, . .
400 droplets, naming options for, 367

for gradients, 228
for layer styles, 291, 293
for layers, 108, 115

native color channels, channel masks from,
244-245

native formats, 444
Navigator panel. See also zooming
area of view, changing, 35
color of view box, changing, 36
shortcuts, 34
size of view, changing, 34
thumbnails
increasing size of, 36
zooming with, 35
Nearest Neighbor method, 54
neon effects, 286
nested layer group, creating, 103
New Document Preset Resolutions, 62-63
new documents
creating, 12
preset resolutions, 62-63
with presets, 14
New Layer dialog box, 101
New Layer Effect button, 323
noise
Add Noise filter, 146
with brush tips, 213
for Drop Shadow style, 277
for Inner Glow style, 288
for Outer Glow style, 286
Reduce Noise filter, 147
nondestructive editing, 21

non-linear state of History panel, 121, 124-
125

non-squared pixels, 15
note paper filter effect, 345

with Custom Shapes tool, 220
for gradients, 227
with Line tool, 217
for Paint Bucket tool, 223
for Paintbrush tool, 214
for Pencil tool, 215
monitors. See also color management
automatically fitting image to, 40
calibrating, 415
resolution, understanding, 396
selecting areas for, 78
soft-proof colors, setting up, 416-417
monochromatic option
with Add Noise filter, 146
with Lens Blur filter, 333
mosaic tiles filter effect, 346
Motion Blur filter
Add Noise filter with, 146
Smart Sharpen filter with, 156
mouse movements in actions, 363
Move Grid tool, 150
Move tool, 11
with Vanishing Point tool, 148
moving. See also layers; paths
adjustment layers, 137
anchor points in paths, 260
with Bridge, 494-495
channel masks between documents, 248

Document window, moving images in,
41

layer styles, 294
with Vanishing Point tool, 148-149
Multi-Channel color mode, 171, 180

multi-layered documents into backgrounds,
converting, 107

Multiply blending mode
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notes, 45
different file formats, save as, 383
saving, 28, 45

0

offset with Pattern Maker filter, 337
on-image controls, 204, 517-520
opacity, 60-61
with adjustment layers, 142-143
for Airbrush tool, 214
with Art History brush, 132
for Bevel and Emboss style, 279
for Color Overlay style, 282
with Custom Shapes tool, 220
for Drop Shadow style, 276
of gradients, 229
for Inner Glow style, 288
Layers panel option, 98
Liquify view option, 329
for Outer Glow style, 286
for Paintbrush tool, 214
with Pattern Overlays, 284
for Pencil tool, 215
setting, 101
for Stroke layer style, 283
Open As command, 16
opening images, 16
Optimize To File Size option, 439
optimizing
image to file size, 439
Photoshop, 52-53
Options bar, 6, 11
organizing documents, 383
outline font, 299
output options, printing, 374-375
out-of-gamut, 60, 173
command, test, 429
Hue/Saturation Adjustment for, 430-431
Sponge tool, working with, 432-433
Out of Scratch Disk Space error, 53
Outer Glow style, 274
working with, 286-287
output options, setting
setting, 460-461
saving, 460-461

Overlay blending mode with Pattern
Overlays, 284

Override Action "Open" commands, 366

P

Page Setup, 370-371
Paint Brush tool, 77
Paint Bucket tool, 11, 223
Paint tools, 10, 205
with layer masks, 234
Paintbrush, 214
with layer masks, 234
as Stroke tool, 269
painting. See also gradients
adjustment layers, opening, 136
on adjustment masks, 144
cursor options, 59
painting engine. See Brushes panel
panel knife filter effect, 344
panels, 6. See also specific types
adding panels, 7-9
customizing, 72
preferences for, 55
showing/hiding, 7-9, 37
subtracting panels, 7-9
working with, 7-9
panoramic photographs, creating, 406-407
Pantone Color Matching System, 413
paper options, 370-371, 377
Paragraph panel, 72
showing/hiding, 299
working with, 301, 302
Paste, preferences for resizing, 55
Patch tool, 160-161
with Reduce Noise filter, 147
patches, checking for, 24-25
Path Selection tool, 262
type path, reshaping, 318
paths, 272. See alsoType tool
anchor points
adding, 260

curved to straight points, converting,
265

deleting, 260-261
direction lines, modifying, 264

with Magnetic option of Freeform Pen
tool, 259

modifying, 262
moving, 260
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paths (continued)

straight to curved points, converting,
265

clipping paths, 253

working with, 266-267
complexity of path, controlling, 258
curved to straight points, converting, 265
deleting anchor points, 260-261
direction lines, modifying, 264
Fill command with, 253, 268
Freeform Pen tool, 258-259

Magnetic option, using, 259
lllustrator, exporting paths to, 271-272
keyboard, moving path with, 262

Magnetic option of Freeform Pen tool,
using, 259

moving
anchor points, 260
keyboard, moving path with, 262

Paths To Illustrator command, exporting
paths with, 272

Pen tools with, 253, 256-257
Save As, exporting paths with, 271
selections into paths, converting, 255
shapes as paths, creating, 270
straight to curved points, converting, 265
Stroke command with, 253, 269
Paths panel, 253
PathsTo Illustrator command, 272
Pattern Maker, 319, 336-337
Pattern Overlays, 273
repositioning, 285
working with, 284-285
patterns
with Paint Bucket tool, 223
for Stroke layer style, 283
for texture, 281
pauses in actions, 356
PBM files, 381
PCX files, 381
PDAs (personal digital assistants), 172
RGB (red, green, blue) color with, 418
PDF files, 381, 397
creating, saving, 404-405
format, 405
inserting images in, 17
layers exported as, 117
metadata information, adding, 385

multi-page PDFs to PSDs, converting,
402-403

PSD file, converting to, 402-403
types of, 404
PDF presentations, 381, 397
creating, 404-405
PDF presets
creating, working, 405
Pen tools
in lllustrator, 257
with paths, 253, 256-257
Pencil tool, 215
Auto Erase and, 216
for calligraphy lettering, 215
perceptual rendering intent, 419
Perspection Web site, 11

perspective of Transform command
selection, 95

Photo Filters, 199, 334
photographic manipulation, 158
photographic restoration, 146
photographs for Web, preparing, 390-391
Photomerge, 406-407
command, 397
Photoshop Extended
3D files, 483
Align layers, Auto, 474-475
Angle, Vanishing Point, 148
Blend layers, Auto, 474-475
Clone sources, panel, 482
Count tool, 470-471
Count tool, preferences, 64-65
Enable 3D Acceleration, 69
Measurement feature, 148, 470-473
MPEG-4 video, 466
Timeline view (mode), 452
video layer
cloning, 481
creating, 477
modifying, 478-479
splitting, 480
picas as measurement system, 33
PICT files, 381
Pincushion distortion, 150-151
Pixar files, 381
Pixel Aspect Ratio Correction, 15
pixelization, 13



pixels, 13. See also adjustment layers;
raster data

Add Noise filter, working with, 146
of data driven graphics, 466
of data sets, 465
Equalize command, 202
with Eraser tool, 206
excess pixels, deleting, 44
Histogram panel, information in, 166
image interpolation, 54
large files, saving, 22
Magic Eraser tool with, 226
as measurement system, 33
non-squared pixels, 15
resolution, understanding, 396
with RGB (red, green, blue) color, 418
Smart Sharpen filter, 156-157
Unsharp Mask filter, 155
Place command
inserting images in documents with, 17
preferences for resizing, 55
plastic wrap filter effect, 346
Play button, Actions panel, 349
play options, 366
playback of command, controlling, 353
plug-ins, 66-67
organizing, 66
Plug-Ins and Scratch Disks preferences, 66-
67
PNG-8 files
information on, 387
optimizing PNG-8 documents, 446-447
saving for the Web, 436-437
PNG-24 files
information on, 387
optimizing PNG-24 documents, 448
saving for the Web, 436-437
PNG files, 381
clipart for Web, preparing, 388-389
compression of, 386-387
layers exported as, 117
metadata information, adding, 385
opening images, 16
Save For Web command with, 436-437
saving documents as, 28
for Web images, 435
Polygonal Lasso tool, 81-84

polygons
Polygonal Lasso tool, 81-84

with Standard Shape tool, 218
portrait orientation, 371
position for Stroke layer style, 283
Posterize adjustment, 203
PostScript type size, 48, 70
precise cursor options, 59
preferences, 51
cursors preferences, 59
File Compatibility options, 57
File Handling preferences, 56-57
gamut preferences, 60-61
General preferences, 54-565
Guides, Grid & Slices preferences, 64-65
interface preferences, 58
Memory & Image Cache preferences,
68-69
plug-ins preferences, 66
scratch disks preferences, 67
transparency preferences, 60-61
Type preferences, 70
Units & Rulers preferences, 62-63
Preset Manager for libraries, 71
presets
new documents with, 14
Preset Manager, 71
saving items and, 71
tools, 50
press, preparing images for, 392-393
previewing
fonts, 70, 298-299
Lens Blur filter option, 333
non-squared pixels, 15
press, images for, 393
with Save For Web command, 438
transparency settings, 60
with Unsharp Mask filter, 155
video preview option, 14
vignettes, 238
Print One Copy command, 380
Print dialog box with preview, 372-373
part of document, printing, 379
printers. See also Windows
calibrating, 415

converting color space to another
profile, 426

preparing images for, 394-395
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printing
Gamut Warning, 372
hard proofs, 420-421
larger images, 380
Macintosh, documents in, 376-377
one copy of document, 380
output options, 374-375
part of document, 379
Print dialog box with preview, 372-373
Show Paper White, 372
target images, 428
Windows, documents in, 376
problems, reporting, 25
progressive option
for JPEG images, 443
photographs for Web, preparing, 391
proof profile information, embedding, 29
Proof Setup, Windows, 383
Protect Texture option, 213
Protect Tones, 159, 432
PSB files, 381
opening images, 16
PSD files, 381
adjustment layers as, 136
creating, 404-405
as a presentation, 405
large files, saving, 22
layers exported as, 117
metadata information, adding, 385

multi-page PDFs to PSDs, converting,
402-403

opening images, 16
PDF files, converting, 402-403
preferences for saving, 57
raw images saved as, 18
puckering with Liquify, 324
purging RAM, 125, 134
pushing left with Liquify, 324

Q

QuarkXpress, 266

EPS documents, type information in, 297
Quick Mask Mode, 252, 250

filters in, 251

options, working with, 251

saving selections, 251
Quick Selection tool, 85

R

radius option, 152-153, 155-157, 219, 333

RAM (random access memory), 51. See
also History panel; History states

adjusting options, 68-69

optimizing, 53

purging RAM, 125, 134
ramps, 183
range values

for Bevel and Emboss style, 280

for Inner Glow style, 289

for Outer Glow style, 287
raster data, 396. See also Layers panel

change and, 369

documents, 13

interpolation and, 254

Smart Objects with, 21

understanding raster images, 254
Rasterize Type command, 308
raw digital camera data, importing, 18-19
RAW files, 18-19, 381

large files, saving, 22
reconstructing with Liquify, 324, 327
Record button, Actions panel, 349
recording actions, 351
Rectangle tool for layer mask borders, 239
rectangles

with Rectangle tool, 239

with Standard Shape tool, 218
Rectangular Marquee tool, 78

with Pattern Maker filter, 336

for printing part of document, 379
RedEye tool, 163
Reduce Noise filter, 147

with Healing Brush tool, 147, 160
reduction

for GIF documents, 444

for PNG-8 documents, 446
Refine Edge

selection, 88

with Layer Masks, 236
relative colorimetric rendering intent, 419

remove option with Smart Sharpen filter,
156

renaming
with Bridge, 498
presets, 71



rendering intent

for hard proofs, 421

for soft-proof colors, 416

working with, 419
reopening notes, 45
repeating Transform command selection, 95
Replace Color command, 181
Resample Image option, 22
resizing. See size
resolution

changing, 22-23

selecting, 13

understanding, 396
retouching images, 158

RGB (red, green, blue) color, 13, 47, 171. See
also color management; out-of-gamut

CMYK (cyan, magenta, yellow, black)
color and, 171, 418

Color Slider, 182

converting image to, 172
with 8-bit channels, 168-169
Gamut Warning mask, 60-61

Lab color mode for archiving images,
178

Multi-Channel color mode, converting
images to, 180

patterns, generation of, 337
press, preparing images for, 392-393
Spectrums or Ramps, 183
right justification, 299
Rise style of warped text, 304
RLE (Run Length Encoding) scheme, 388
Rotate View tool, 41
rotating
with Bridge, 494-495
with Lens Blur filter, 333
Smart Objects, 21
Transform command selection, 95
roughness of gradients, 229
rows. See columns and rows
rulers, 48-49, 51
guides, working with, 48-49
options for, 62-63
switching between measurements, 62

S

Saturate and Desaturate command, 167

saturation. See also HSB (hue,
saturation, brightness)

rendering intent, 419
Saturate and Desaturate command, 167
Save As command, 29
paths exported with, 271
with text, 299
Save commands.
understanding, 29
Save For Web command, 436-437
Save for Web dialog box, 439
Save Mesh button, 330
Save Optimized As command, 441
saving. See also actions; layer styles
alpha channels, 28
brush tips, 212
channel masks, 246-247
custom shape sets, 222
documents, 28-29
file formats, files with different, 382-383
File Saving options, selecting, 56
gradients, 228-229
History states, 128
image pyramid, 395
inserting file information into docu-
ments, 384-385

large files, 22, 57
layer styles, 292
layers, 28
Liquify meshes, 331
notes, 28, 45
presets, items as, 71
Quick Mask selections, 251
spot colors, 28
Swatches panels, 185
thumbnail data, 29
understanding Save commands, 29
for Web, 436-438
scaling
Content-Aware scaling, 96, 503-505
Character panel selections, 301
in Macintosh Page Setup, 370
with Pattern Overlays, 285
in Print dialog box with preview, 373
Smart Objects, 21
for texture, 281
Transform command selection, 95
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scanners
calibrating, 415
noise from, 147
photographs for Web, preparing, 391
Photoshop, scanning images into, 17
Scattering, 208, 213
Scratch Disks, 51, 53, 66-67
scratch sizes, 30
Info panel displaying, 47
Screen blending mode, 142
with Pattern Overlays, 284
Screen Mode for display, 37
scripts
built-in scripts, 365
enhanced scripting, 364-365
scroll wheel preferences, 55
SCT files, 381
searching. See Find and Replace
Select menu options, 89
selection marquees
hiding, 433
selection masks, 92-93
selections, 10, 77-96. See also specific tools
adding to, 90
Brightness/Contrast adjustment with, 193
channel masks from, 243
channels, creating with, 92
by color range, 87
cropping selections, 91
filters, controlling, 339
with Free Transform command, 94
layers, 102
layer masks, generation of, 235
layer options, selecting, 101
masks, 92-93, 145
layer masks, generation of, 235
modifying existing selection, 89
paths, converting to, 255
Quick Mask option, 252
Quick Selection tool, 85
Refine Edge, 88
subtracting from, 90
with Transform command, 94-95
vignettes, creating, 238
Selective Color adjustments, 167, 196
sepia color, Fill blending with, 187
sets. See actions

Shadow Angles option with Drop Shadow
style, 276

Shadow/Highlight adjustment, 200

shadows
for Bevel and Emboss style, 279
with Dodge and Burn tools, 159
Shadow/Highlight adjustment, 200
tonal range, controlling, 164-165
with Variations adjustment, 189

Shape Blur filter, 152-153

Shape Dynamics, 208, 213

shape layers, 99
drawing option, 270

Shape Marquee tools, 11

Shape tool, 205

shapes
Custom Shapes tool, 220-222
Lens Blur filter option, 333
paths, creating shapes as, 270
with Standard Shape tool, 218-219

Type tool, creating shape layers with,
310

Share My Screen, 488, 499
sharing
actions, 361
layer styles, 293
Shell Lower/Upper style of warped text, 304
Shift key for tools, 11
shortcut keys, 3, 4
defining, 73
filters, reapplying, 321
with Navigator panel, 34
for tools, 11
working with, 73
zooming with, 39
Show Bounding Box check box, 372
Show Paper White, 372
Show This Dialog At Startup check box, 5
showing/hiding
channel masks, 241
Character panel, 299
layer styles, 275
layers, 108
Navigator panel, 35
panels, 7-9, 37
Paragraph panel, 299
selection marquees, 433
toolbox, 37



shutter speed information, 384
Single Row/Column Marquee tools, 80
size
adjustment layers and, 135
for Bevel and Emboss style, 278
of CMYK document, 171
of documents, 30
for Drop Shadow style, 277
image size, changing, 22-23
Info panel, information in, 46, 47
for Inner Glow style, 289
for Outer Glow style, 287
photographs for Web, preparing, 391
preferences for resizing, 55
for Stroke layer style, 283
view size, changing, 34
sketch filters, 320
skewing Transform command selection, 95
Slice Selection tool
with Save For Web command, 438
slicing images, 454-455
arranging, 458-459
distributing, 458-459
HTML text, add, 462-463
saving for the Web, 460-461
setting output options, 460-461
stacking, 458-459
URL, add Web address, 462-463
working with, 64-65, 456-457
slide shows, 404-405
sliders, changing text boxes to, 74
Smart Filters
Creating, 322
Smart Objects, from, 20-21
Working with, 322
Smart Guides, 119
Smart Objects, 20-21
converting 3D layer to, 21
Smart Sharpen filter, 156-157
smoothness
of gradients, 229
with painting engine, Brushes panel, 213
snapshots, 122
creating, 126
with History brush, 131
softness
for Bevel and Emboss style, 278

channel masks, 247

layer masks generating soft
transparency, 236

soft-proof colors, setting up, 416-417
software color calibration, 415
sounds, preferences for, 55
source option for Inner Glow style, 289
spacing Paragraph panel selections, 302
Spatter filter, 346
for layer mask borders, 239
specific size object, creating, 43
spectrums, 183
speed of Photoshop, adjusting, 68-69
Spell Check, 295
Character panel selections, 301
working with, 306
Sponge tool, 159
desaturating areas of image with, 194
for out-of-gamut colors, 432-433
spot colors, 188
different file formats, saving documents
as, 383
saving, 28
Spot Healing Brush tool, 162
spread values
for Drop Shadow style, 277
for Outer Glow style, 287
squares with Standard Shape tool, 218
Squeeze style of warped text, 304
stacking images, 474
stacking order of layers, 108
stained glass filter effect, 346
stamp filter effect, 345
Stamp tool
Clone Stamp tool, 158
with Vanishing Point tool, 148
Standard Mask Mode, 250
Standard Pen tool with paths, 256
Standard Screen Mode, 37
Standard Shape tool, 218-219
Options bar, 11
stars with Standard Shape tool, 219
Status bar, 30
Stop button, Actions panel, 349
straight lines
drawing, 210
Line tool for, 217
Pencil tool for, 216
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Straighten tool, 150
Stroke command, 186
for paths, 253
with paths, 269
Stroke layer style, 283
Stroke Path option, 269
styles. See also layer styles
for Art History brush, 132
for Bevel and Emboss style, 278
Styles button for warping text, 304
Styles panel, 273
layer styles, creating, 292-293
stylize filters, 320
subfolders
in Batch File Processing, 395
Include All Subfolders command, 366
subtracting from selection, 90
Suppress Color Profile Warnings, 366
Suppress File Open Options Dialogs, 366
Surface Blur filter, 152-153
Swatches panel, 184-185
customizing, 185
saving, 185
system requirements, 3

T

tablecloth, 60
Targa files, 381
layers exported as, 117
target images, printing, 428
technique
for Bevel and Emboss style, 278
for Inner Glow style, 289
for Outer Glow style, 287
text, 33. See also anti-aliasing; notes; Spell
Check; Type tool; warping
Asian text options, 70
chiseled text, creating, 288
of data sets, 465
History state text files, reviewing, 129
Rasterize Type command, 308
workspace for, 72
text boxes to sliders, changing, 74
textures, 208, 213
with Bevel and Emboss style, 280-281
filters, 320
Protect Texture option, 213

thawing with Liquify, 325
32-bit images, See also High Dynamic
Range (HDR) images
3D effects, Bevel and Emboss style for, 278
3D model files
adding to a 2D model, 483
converting 3D layer to Smart Object, 21
creating from a 2D image, 484
editing a model, 485
threshold, 203
with Lens Blur filter, 333
with Surface Blur filter, 152-153
with Unsharp Mask filter, 155
thumbnails. See also Navigator panel
with Bridge, 13
in Brushes panel, 209
dragging layer thumbnails, 44
file saving options, 56
Layers panel thumbnail size, changing,
118
with Save For Web command, 438
saving thumbnail data, 29
TIFF files, 381
adjustment layers as, 136
large files, saving, 22
layers exported as, 117
metadata information, adding, 13, 385
opening images, 16
photographs for Web, preparing, 390-391
preferences for saving, 57
printers, preparing images for, 394-395
raw images saved as, 18

tile boundaries with Pattern Maker filter,
337

tolerance
for Art History brush, 132
with Paint Bucket tool, 223
for paths, 255

tonal values
controlling, 164-165
Histogram panel and, 166
Invert command for, 202
with Smart Sharpen filter, 157
with Surface Blur filter, 152-153

tool tip preferences, 55

toolbox, 6
showing/hiding, 37

tools. See also specific tools



multiple tools, accessing, 10
working with, 10-11
tracking Character panel selections, 301
Traditional type size, 48
transfer functions for press images, 393
Transform command, 94-95
with Vanishing Point tool, 148
transparency. See also layer masks
clipart for Web, preparing, 388
clipping paths and, 266-267
for GIF documents, 445
for gradients, 227
gray creating, 232, 234
with History brush, 133
for JPEG images, 443
layer styles requiring, 274
for PNG-8 documents, 447
for PNG-24 documents, 448
preferences, 60-61
printer, preparing images for, 395
soft transparency, generating, 236
for Web design, 437
turbulence with Liquify, 325
turning on/off Smart Guides, 119
Twain plug-in, scanning images with, 17
twirling with Liquify, 324
Twist style of warped text, 304
Type preferences, 70
Type tool, 10, 295-318
chiseled type, creating, 314-315
editing type on path, 297
fonts, working with, 298-299

horizontal and vertical type, toggling
between, 298

layers

creating, 99

shape layers, creating, 310
masks
chiseled type, creating, 314-315
creating type masks, 311
layer masks, combining with, 316-317
pixels, isolating, 312-313
special effects, generating, 316-317
moving type mask, 312
options, working with, 298
paths, 296-297, 309

text on path, creating, 318

work paths, creating, 309

preferences for, 70
Rasterize Type command, 308
Type tool
shape layers, creating, 310
special effects, generating, 316-317
standard typing tools, 296-297

U

undos, 52. See also History panel

multiple undo commands, performing,
122

unified color table
for GIF images, 445
for PNG-8 documents, 447
units, 51. See also rulers
options for, 62-63
Unsharp Mask filter, 1565
Updater, 24-25
updates
checking for, 24-25
from Internet, 24
layer comps, updating, 116
options, setting, 4
for versions of Photoshop, 2
user interface, customized, 74-75

vV

Vanishing Point tool, 148-149
Variations adjustment, 189
vector data
interpolation and, 254
Paths panel and, 253
press, images for, 393
Smart Objects with, 20-21
understanding vector images, 254
Version Cue, 30
preferences, 57
Vertical Type Mask tool, 311
vibrance, 169
video
exporting, 466-467
layers, cloning, 481
layers, creating and modifying, 477-478
layers, splitting, 480
new documents with video presets, 14
opening, formats, 476
preview option, 14

Index

553
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views and viewing. See also Navigator
panel

Bird’s Eye view, 38-39

with Bridge, 490, 494-495

for Brushes panel, 209

Liquify view options, 329

Photoshop window, 6

RGB color mode, 13, 171

size of view, changing, 34

two views, working on one image in, 43

Zoom tool, changing view with, 38-39
vignettes

with layer masks, 238

Lens Correction filter, vignetting and, 150
visibility

of data driven graphics, 466

of data sets, 465

W

Wacom drawing tablets, 76
Warped Text button, 299
warping
with Liquify, 324
Smart Objects, 20-21
text, 299, 304-305
Transform command selection, 95
watermarks
embedding, 319, 342-343
restricted, 343
Wave style of warped text, 304
WBMP files
optimizing WBMP documents, 449
Save For Web command with, 436-437
for Web images, 435
Web Content panel, 461
Web design, 435-470.
file formats, working with, 446-441
optimizing image to file size, 439
saving documents for, 436-438
Web images
clipart, preparing, 388-389
Color Slider, 182
lossy/lossless compression, 386-387
photographs for Web, preparing, 390-391
preparing, 369
Web snap
for GIF documents, 444

for PNG-8 documents, 446
Wet Edges, 213
width values
Fit Image command, 412
with Line tool, 217
with Pattern Maker filter, 337
print size option, 373
Windows
color calibrator in, 414
ICC Profile, 383
Microsoft ICM color management, 426
Page Setup in, 371
printers
preparing images for, 394-395
setting up, 371
printing documents in, 378
Proof Setup, 383
workspace, customizing, 72
WYSIWYG type, 70

X

XMP files, 13

inserting file information into
documents, 384-385

XMP Software Development Kit, 385

z

ZIP files

compression of, 387

printers, preparing images for, 395
Zoom tool, 33

with Lens Correction filter, 150

with Save For Web command, 438

two views, working on one image in, 43

with Vanishing Point tool, 149

view of image, changing, 38-39
Zoomify, export, 468
zooming, 6. See also Zoom tool

area of view, changing, 35

with Liquify, 325

monitor, automatically fitting image to,

40

on multiple documents, 40

with Navigator panel, 34-35

100%, automatically zooming to, 40

preferences for, 55

with shortcut keys, 39
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